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About This Document

This documentation covers installation and upgrading of the Zen database system. Zen is a
complete database management system, combining a MicroKernel Engine designed for high-
performance data handling and improved programming productivity with an embeddable,
scalable relational engine.

This guide also contains information about common installation issues, general network protocol
information, and Zen optional features.

For information on using Zen utilities, see Zen User’s Guide. For information about customizing
the configuration of the Zen database engine beyond the default setup, see Advanced Operations
Guide.

We would appreciate your comments and suggestions about this document. Your feedback can
determine what we write about the use of our products and how we deliver information to you.
Please post your feedback in the community forum on the Actian Zen website.



https://www.actian.com/data-management/zen-embedded-database/




Welcome to Zen

The following topics introduce the Zen database product:

About Zen

The Zen MicroKernel Engine
The Zen Relational Engine
About the Zen Database Editions
Zen SDK

About Zen

Zen is a reliable, low-maintenance, high-performance database management system (DBMS).
Thousands of companies around the world license Zen and distribute it as the underlying data
storage program for their data-intensive software products. These companies see no reason to
build their own DBMS or license from a competitor once they experience the ease-of-use,
reliability, and value offered by Zen.

No matter whether you received Zen with another product or purchased it yourself, this section
explains a little about the product and why it is right for its purpose.

Competitive Advantages

Zen provides a number of advantages over other products available on the market. Here are just a
few:

Lowest total cost of ownership. An independent study conducted by Aberdeen Group
concluded that no major database product can match the Zen low total cost of ownership. How
do we do it? See the next bullet.

No Database Administrator (DBA) required. You can look in the newspaper any day of the
week and see classified ads for Oracle, Sybase, or SQL Server database administrators, with
sky-high salaries. Zen offers the unique Zero Database Administrator, or Z-DBA™,
architecture. Its easy-to-use tools, bulletproof installation, and set-it-and-forget-it simplicity
make it the perfect workhorse for desktop, workgroup, and departmental applications.

Scalable from the desktop to the Web. Zen is available in two editions: the Ultra-light™
Workgroup database engine supports single-user configurations up to small workgroup
configurations. The Enterprise Server engine comes with a six-user license and scales to




hundreds of concurrent users, including intranet and extranet applications. Upgrading to
another configuration requires no changes to the supported application, just plug and play
with the new database engine.

* Cross-platform support. Unlike some competitors, Zen does not lock you in to a single
platform. Zen databases are binary-compatible and supported across Microsoft Windows and
several varieties of Unix-based platforms.

* Bigdatabase features at a small price. Zen offers full security, encryption, management and
monitoring tools, and a host of other features you would expect to see in more expensive
DBMS products.

» Legendary stability and reliability. There’s no doubt why the Windows desktop accounting
market uses Zen as the underlying database of choice. When you’ve got to manage important
data, you go for the database engine that won’t let you down.

*  Multiple access methods. Your application vendor can use the Btrieve API for blazing
performance on bulk data operations, while offering the richness of ODBC, pure Java, and
JDBC interfaces for data reporting, security, analysis, and standard compatibility. No other
database management system offers all these access methods.

Transactional (Direct Data) Access or Relational Access

Zen offers an architecture that is totally unique in the database management market. Our product
allows you to access the exact same data through the MicroKernel Engine and through the
Relational Engine.

The transactional database engine, called the MicroKernel Engine, interacts directly with the data
and does not require a fixed schema to access it. It uses a key-value associative array to store and
access the data. Calls to the MicroKernel Engine are made programmatically with Btrieve API
rather than through a query language, and so Zen does not have to parse the request. This places
the MicroKernel Engine in the category of NoSQL databases. Low-level API calls and memory
caching of data reduce the time required to manipulate data. See The Zen MicroKernel Engine.

The second database engine, the Relational Engine, operates in a manner similar to other
relational database engines, that is, through the support of Structured Query Language queries.
The Relational Engine parses SQL queries and sends them to the MicroKernel Engine to run. See
The Zen Relational Engine.




The Zen MicroKernel Engine

The Zen MicroKernel Engine offers easy installation, uncomplicated maintenance, and high
levels of performance and reliability. Zen provides a foundation on which you can run
transactional applications or migrate to a relational database system.

Benefits

Zen MicroKernel Engine and its Btrieve API has been the data management system of choice for
tens of thousands of applications around the world for more than 25 years now. In the highly
competitive accounting software market — where reliability and performance are paramount —
many of the top 10 vendors choose Zen. Many application developers choose Zen for its speed,
data integrity, easy scalability, and low maintenance costs.

* Speed. The MicroKernel Engine is capable of subsecond response rates, even when building
multigigabyte databases for hundreds of users. The engine achieves these high speeds through
features such as internal indexing algorithms that cache pages for fast data retrieval and
updates, and automatic index balancing to maintain fast data access, even as your files grow.

* Data Integrity. The MicroKernel Engine guarantees data integrity through rich transaction
processing support, referential integrity controls, and automatic file recovery. In the event of a
server or system failure, logging features and roll forward utilities allow you to recover data
up to your last completed transaction.

* Scalability. Many client-server database applications begin on the desktop and scale with
corporate growth. Zen provides easy scalability from workstation to large client-server
environments.

» Low Cost. The low support costs experienced by Zen developers translate into low
maintenance costs realized by Zen application end users. Zen eliminates the need for
sustained database administration through automatic data recovery functions and easy-to-use
utilities.

Features

The MicroKernel Engine offers many features, including the following:

» Direct interaction with the data that does not require fixed data schema to access the data. It
uses a key-value system to store and access the data.

+ Calls to the engine are made programmatically with the Btrieve API rather than through a
query language, meaning that Zen does not have to parse the request.

» Low-level API calls and memory caching of data reduce the time required to manipulate data.




» Access to databases distributed across multiple engines.
* Robust transactions for both single-server systems and distributed multiserver systems.

» The engine operates in complete database transactions and guarantees full ACID (Atomicity,
Consistency, Isolation, Durability).

* Records are stored in files which are roughly equivalent to the tables of a relational database
engine. It supports multiple keys on a record and therefore multiple indexes in the file.

The Zen Relational Engine

The Zen Relational Engine offers easy installation, uncomplicated maintenance, and high levels
of performance and reliability.

Benefits

Many relational database application developers choose Zen because it provides scalability,
maintenance-free operation, and a small memory footprint:

» Standard Interface. SQL and ODBC provide a well-known and standardized foundation upon
which to build useful applications.

*  Speed. Zen offers direct ODBC access to the database engine. Many competitive products use
a translation layer to translate ODBC calls to proprietary “native” relational API calls that
then access the database engine. In contrast, the Zen ODBC driver calls the database engine
directly, without translating ODBC calls to a proprietary relational API.

* Scalability. Zen allows you to scale applications from single-user to large client-server
environments without changing the application or the database.

* Maintenance-Free Operation. Zen is simple to install and use. It requires no extensive setup
or ongoing performance tuning by a database administrator.

*  Small Memory Footprint. Zen has a limited footprint, requiring only a small amount of
memory.

Features

The Relational Engine provides a flexible architecture that helps you easily scale your database
applications from large client-server systems to single-user environments without additional
coding. Zen offers easy installation, uncomplicated maintenance, high levels of performance and
reliability, and a smooth migration path for data. In addition, bundling Zen with your application




is easy with the Zen distribution component, which provides multi- and single-user run-time
support.

* Application scalability from standalone to client-server

* Fully functional Workgroup and client-server engines

» Declarative referential integrity

» Bidirectional, updateable, and scrollable cursors

* Named database support providing location transparency for applications

» Comprehensive, industry standard data type support

* Programming extensions such as triggers and stored procedures

* Cost-based optimization from statistical analysis and enhanced fetch algorithms
» Transaction processing enhancements such as full transactional logging

» Standards enhancements, including ODBC and ADO.NET support

* Other features include additional Windows utilities, large file support (up to 256 GB), and
additional data type variables such as TIMESTAMP, UNSIGNED, and CURRENCY.

About the Zen Database Editions

This topic provides basic information about the Zen Enterprise Server, Cloud Server, and
Workgroup editions. For a discussion of Zen architecture, see The Zen Component Architecture
in Advanced Operations Guide.

Zen Enterprise Server and Cloud Server

Zen Enterprise Server is designed to support up to many hundreds of concurrent network users
when installed on the required hardware. It is capable of supporting web, corporate, departmental,
and other client-server or web-based applications where reliability and performance are critical.

Zen Enterprise Server and Cloud Server differ in that Cloud Server supports capacity-based
licenses for service bureau, software as a service, or other multiplexed environments, while
Enterprise Server supports licenses for end-user client-server applications. No additional license
is required for use with hypervisor features such as live migration, failover, fault tolerance (FT),
high availability (HA), and disaster recovery.




Zen Workgroup

Zen Workgroup is designed to support single-user or small workgroup installations.

Zen Workgroup offers the same level of reliability and features as Zen Enterprise Server. The only
differences lie in networking and performance in mid- and large-size environments.

Zen Workgroup offers a flexible approach to accessing data on remote servers in a variety of
small network configurations. If you have data files on a remote file system with no database
engine present, you can configure Zen Workgroup so that a particular engine is always used to
access the remote data, or you can set it up so that the first engine to access the files acts as a
server for those files until there are no more requests for data. After this point, the next engine to
access the files then owns them while requests are coming in.

A Zen license cannot be installed on more than one machine. Your user count license refers to the
number of client connections allowed to that engine, not to the number of machines to which you
are allowed to install the Zen engine. In a Workgroup environment, every machine that will access
Zen data should have the Workgroup engine installed.

Server and Workgroup Comparison

The following table lists differences between the Server and Workgroup editions.

Feature Server Workgro
up

Supports a variety of access methods (see Zen SDK) X X

Full-featured relational support (online backup, security, referential X X

integrity, management tools, and so on)

Binary compatible data files across all platforms and engine editions X X
Easy plug and play upgrading, no application changes required to change X X
engines.

Includes complete online documentation X X
Can access data on a file server where no database engine is installed X
Supports remote ODBC client connections X X
Requires Workgroup Engine on all computers expected to access remote  does not X
data apply

Engine runs on Windows X X




Feature Server Workgro

up
Engine runs on Linux and Raspbian X
Multiuser for small groups X X
Scales to thousands of users X
Extranet license available X
Enforces operating system security X
Supports a Client Reporting Engine X X

Zen SDK

The Zen SDK includes many features to ease the burden of application development.

» Low-level APIs. Direct programming to the Btrieve API gives you the fastest possible data
access and the most control over the way in which your application reads and writes data. If
these considerations are important to you and you are willing to develop the code that
incorporates your business rules, you may find direct API programming highly useful. For
relational access to data, you may also code directly to the Microsoft ODBC API.

e  ODBC. Zen offers a native ODBC driver.

* ADO.NET data provider. The Zen edition of this data provider provides support for the
Microsoft .NET Framework, and is an ADO.NET-managed data provider, built with 100%
managed code.

* Java. The Java Interface gives you the option of developing Btrieve applications in an object-
oriented, platform-independent manner. It includes support for true null and Unicode values
as well as for Binary Large Objects (BLOBs).

* Distributed Tuning Interface and Objects. These two related interfaces allow applications to
tune and manage the database engine itself, including configuration parameters and aspects of
security.

»  Complete sample application. Zen SDK includes a complete sample application designed to
run a video rental store. Full sample code in Visual Basic, Delphi, Java, and C/C++ is
supplied. Examples using ODBC, third-party controls, and direct API calls are shown.

» The Actian website is an online resource that gives you access to the latest Zen component
downloads, code samples, documentation, and technical support.



https://www.actian.com/data-management/psql-embedded-database/

Development Environment

Zen provides an open interface that allows you to develop many front-end applications, all of
which can share a common transactional or relational database. You can use popular
programming languages and environments such as Java, Delphi, BASIC, Visual BASIC, .NET, C,
C++, COBOL, Pascal, ODBC, PowerBuilder (through ODBC), and FoxPro (through ODBC). In
addition, you can bundle a Zen engine with your application using a Derivative Software License.




Preparing to Install Zen

The following topics prepare you to install Zen by providing an overview of the requirements, the
major components included in Zen, the installation options available, a detailed checklist to help
you gauge your readiness to proceed with the Zen installation.

» Installation Requirements
* Installation Options

* Zen Products

* Zen Optional Features

* Installation Review

Installation Requirements

You may need to know about the following requirements to complete a Zen installation. This list
supplements the software and hardware requirements found in the release notes.

Access Rights

You must have administrator rights to install Zen Enterprise Server, Cloud Server, or Workgroup.

No Other Zen Database Engine Installed

You cannot install an edition of Zen on the same machine with another edition. You must uninstall
the other edition first. For example, Zen Workgroup cannot run on the same machine as either Zen
server edition.

Upgrading to a New Version

To upgrade from a previous version of Zen, you must upgrade to the same edition of the new
version. For example, if you are using Workgroup, you must upgrade to Workgroup and not to
Enterprise Server. To change editions, you must first uninstall the existing edition. The exception
is that you may upgrade from Enterprise Server to Cloud Server, or from Cloud Server to
Enterprise Server.




Operating Requirements

In a VM environment that supports live migration, an authorized Zen instance — along with your
application — can move from one host to another host with no impact to your end users.

So long as the host name is kept consistent, an authorized instance of Zen can be moved to a
different physical machine, or converted into a VM, or migrated to a different VM host. If you
must change the host name, then deauthorize the Zen license key before moving, converting, or
migrating. Each instance of Zen, including those that are cloned or copied for VMs, requires its
own permanent key even if the host name is the same. For more information, see License Model
in Zen User’s Guide.

Installation Options

On Windows operating systems, Zen offers complete and custom installation options.

On Linux, each edition has its own separate installation TAR file, which does not provide custom
installation options. Raspbian also uses a TAR installation.

Complete Installation
A complete installation is recommended for most users. It uses default installation settings and
installs Zen and all of its features to the standard location for each operating system.

Custom Installation

A custom installation is recommended for users that need control over their Zen installation.
Custom installation allows you to install Zen, along with only the features you select, in directory
locations of your choosing. The customization is available for all Windows platforms except
Nano Server and [oT Core.

Zen Products

Zen is available in Enterprise Server, Cloud Server, or Workgroup, and Client editions. This topic
lists Zen products and the components of each edition.

Enterprise Server and Cloud Server

* MicroKernel Engine, which provides Btrieve/MicroKernel API support for Zen applications.




Relational Engine, which provides ODBC/SQL API support for Zen applications.

Client Requesters and required components to access a MicroKernel engine from Windows,
Linux or Raspbian.

Zen Distributed Tuning Interface (DTTI) is used to configure and monitor the Zen components
from low-level (compiled) applications.

Workgroup

MicroKernel Engine, which provides Btrieve API support for Zen applications.
Relational Engine, which provides ODBC/SQL API support for Zen applications.

Client Requesters and components needed to access a MicroKernel engine for Windows or
Linux.

Zen Distributed Tuning Interface (DTI) is used to configure and monitor the Zen components
from low-level (compiled) applications.

Client

Zen Client requesters and components needed to access a MicroKernel engine from Windows,
Linux, and Raspbian.

Zen Distributed Tuning Interface (DTI), used to configure and monitor the Zen components
from low-level (compiled) applications.

Zen Cache Engine

Note: On Linux, 32-bit client applications require an additional 32-bit Zen client access package
installed after the 64-bit Zen client or enterprise package.

Zen Optional Features

During a custom installation, Zen features may be excluded with the Zen product you are
installing. The features listed here are optional, so if all the features in this section are excluded
from the install, the Zen product is still installed by default.

The following lists the optional features available with each Zen installation, unless noted
otherwise.




Access Methods

Zen access methods include the Zen Software Development Kit (SDK) and the DOS Requester.

ADO.NET Provider

ADO.NET is a .NET managed data provider, built with 100% managed code. The data provider is
a native wire protocol provider, which means that the data provider will not have to call out to
unmanaged code — code outside of the .NET Framework — in the form of a database client.

Btrieve DOS

The DOS VxD (Virtual eXtended Driver) (DOS client requester) is the Btrieve requester used for
running DOS based applications via a Windows Command window. (Transactional access only)

DTO

Zen Distributed Tuning Objects (DTO) are used from visual development environments.

JCL

The Java Class Library (JCL) is used for direct transactional access to data files via Java.

JDBC Driver

The JDBC driver is used for relational access to data files using the Java programming language.

PDAC

Zen Direct Access Components (PDAC) include a set of Visual Component Library (VCL)
components that allow direct transactional and relational access to Zen database engines from
within the Borland Delphi and C++ Builder Environments.

Note: Downloads for design time components and samples are available for each access method
on the Actian website.

Utilities
The minimum set of utilities used to manage, configure and maintain the various components of

the Zen database engines. The utilities included in this base set are installed as a set for all Zen
products and may not be individually excluded from installation.
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* Function Executor

* Btrieve Maintenance

* Rebuild

* Query Plan Viewer

* License Administrator

* Gateway Locator (Workgroup Engine only)

Cobol Schema Executor

The Zen Cobol Schema Executor utility is used for providing SQL access to COBOL based
applications.

Data Dictionary File Builder

Zen Data Dictionary File Builder is used for creating and modifying Data Dictionary Files
(DDFs).

Zen Control Center

Zen Control Center is used for creating and manipulating database objects and accessing database
tables via SQL.

Zen System Analyzer

Zen System Analyzer utility is used for testing and troubleshooting network connectivity, viewing
loaded modules and performing a component search.

Documentation

Zen engine and SDK documentation is integrated into Zen Control Center (ZenCC). You can
access the documentation from the ZenCC interface in the Welcome tab, in the Help menu, or by
pressing F1 (Windows) or Shift F1 (Unix). The documentation is also available online at the
Actian website.

Note: If you choose to not install the documentation, context sensitive (F1) help will be
unavailable from all of the Zen utility graphical user interfaces.
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Java Runtime Environment (JRE)

Zen needs JRE components for the following features:
» ZenCC

* DDF Builder

» Core utilities

e Documentation

These features use a JRE installed with Zen. This local, private JRE is installed even if other Java
environments exist in the system. In a default installation, its location is C:\Program Files
(x86)\Actian\Zen\bin\jre.

This JRE is only for internal use by the features listed above. It has no effect on requirements for
developing Java applications using the Zen access methods for Java Class Libraries (JCL) or
JDBC. Those requirements, including components obtained from Oracle, are discussed in the Zen
SDK documentation. See Java Class Library Guide and JDBC Driver Guide.

If you need to upgrade the Java version used by Zen, we recommend that you simply replace the
JRE in this location. You can use any 32-bit JRE version 8 or higher.

Installation Review

The following checklist helps you prepare for installation and includes a set of commonly asked
questions to review before installation.

Quick Checklist

This checklist covers requirements to install Zen. Each should be met before running the
installation.

O Your system hardware meets the minimum requirements to install Zen.
Your operating system and network environment is supported by Zen.
Windows operating systems need to have applied the latest Microsoft updates.

You have full administrator-level rights on the system where you plan to install Zen.

I I 1 R I B

You understand the different options available in the Complete and Custom installation setup
so you can install only the set of components you need.




O You have reviewed the release notes in readme_zen.htm on the installation media for
important, late-breaking warnings and information that could not be included as part of the
user documentation but may be essential to your installation and use of the product.

O If you are using a proxy server, you need to configure it to allow authorization of Zen.
Configure the proxy server before you install Zen, or omit product authorization during
installation and authorize the product after configuring the proxy server. See Authorization
Access Through a Proxy Server in Zen User’s Guide.

O You have a good understanding of User Access Control (UAC), as well as the differences and
limitations of Standard Users versus Administrators and also have the appropriate permissions
to install on the target system.

O Your application vendor supports the Zen engine.

Tip... Ifyou are uncertain, contact your application vendor or review the documentation provided
by your vendor to ensure that they support the Zen engine version and mode that you want to
install.

Common Questions Before Installation

This topic contains some of the most common questions asked prior to installing Zen. These
questions represent special case scenarios that could possibly prevent a successful first-time
installation. Before you begin installation, consider the situations represented by these questions,
along with the Quick Checklist to determine if you have met all the requirements and if there are
situations that need special attention.

Where do linstall Zen Enterprise Server or Cloud Server?

Zen Enterprise Server and Cloud Server must be installed on the same computer where the
database files are located.

What about the server’s client software?

Zen Client must be running on each machine expected to access the database, whether or not the
client is on the same machine as the server.

Zen Client is installed with every database engine, so any engine can to connect to any other
engine as a client.
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Where do |l install Zen Workgroup?

The Zen Workgroup engine can be installed on the same computer where the database files are
located, or it can be installed on other computers to access the data over the network.

What about Workgroup clients?

Zen Client is installed with every engine. If you access remote files through another Workgroup
engine, the Client software is already installed, so you do not need to install Client separately.
How do l install Zen in a Microsoft Cluster Server environment?

If you plan to install Zen in a clustered environment using Microsoft Cluster Server (MSCS), first
read High Availability Support in Advanced Operations Guide. This topic provides instructions
for installing or patching Zen in this environment.

Running virtual machines within an MSCS environment may depend on considerations covered

in the documentation for the hypervisor vendor.

How do linstall Zen in a Microsoft Remote Desktop Services or XenApp
environment?

If you install the Workgroup engine or Client Cache engine in a Remote Desktop Services or
XenApp environment, you must install the engine to run as a service.

How do |l install Zen in a Microsoft Active Directory environment?

Installation of the Zen database engine in an Active Directory environment requires no special
steps. Follow the installation steps as described for the product you purchased.

You may install the Zen database engine on a domain controller. Be aware, however, that activity
on the domain controller may affect the performance of the database engine.

Where do |l install Zen Clients accessing web applications?

For web applications, the Client must be installed on the same computer as the web server.
Multiple web server platforms require a client on each platform.

Does the Zen Client version have to match the Zen Server version?

We recommend that you use Client installations that are the same version as the database engine.
If you choose, you may use a Client version that is older than the database engine with which it




interacts. In some situations, depending on the type of SDK access method used by your
application, an older version requester will not work with the database engine. Your application
will be unable to communicate with the database engine. For those situations, you must use
clients that are the same version as the database engine.

Clients that are a newer version than the database engine may or may not function correctly. We
cannot guarantee that newer Client versions will function correctly with older versions of the
engine. Therefore, we recommend that you avoid the use of newer version Clients with an older
engine.

Does it matter where | download the Zen installer?

Yes, it does matter. If you are installing a downloaded version of Zen, do not place the installer
file in a location listed in the Path environment variables, since this can cause issues with file
copying during installation. Place the installer in a location such as the Windows %Temp%
directory.

My system runs 24/7. What is the best time for installing or upgrading
Zen?

The installation and upgrade should be performed during a period when all users are logged off
the system and all data files are closed. As with any significant software installation, be sure to
back up any important files on the target hard drive, including data files, before you begin the
installation.

If you are performing an upgrade, keep the installation media and instructions from the old
installation, in the unlikely event that you need to fall back to the previous version of the product.

How can I restrict users running in Terminal Services from changing
Zen configuration settings, creating DSNs, and using the Monitor
utility?

Zen clients running within Terminal Services client sessions can perform Zen administrative
functions by default. For example, a user with such a client can change configuration settings for
Zen, create DSNs, and use the Monitor utility. In prior releases, the ability to perform
administrative functions was prohibited from the client.

To restrict this capability, a system administrator should follow these steps:

1. From ZenCC, open the properties for the MicroKernel Router under Local Client.
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2. On the Properties dialog, check the option Restrict Administrative Functions from a WTS
Client.

3. Click OK, then exit ZenCC and start it again for the setting to take effect.

Are there special settings not listed here that I need to make for my
configuration?

Yes, some default settings in a Zen configuration need to be adjusted in certain situations, such as
any of the following:

*  Multiple network interfaces
» Database files that must not include embedded spaces
» Microsoft Active Directory Service

* A network that is subject to outages

For more information, see Configuration for Special Installation Situations, especially if you find
unexpected behavior after installation.




Upgrading Your Installation for Windows

The following topics cover upgrading to the current release from a supported previous version on
Windows. They include configuration settings migrated during the upgrade.

* Upgrading to Zen v16 from a Previous Version

*  Common Questions After Upgrading

Throughout this documentation, “Zen” without an explicit version number means all versions.

Upgrading to Zen v16 from a Previous Version

If you are upgrading a previous version of Zen to Zen v16, follow the same procedure as you
would if you were installing for the first time. See Installing Zen Enterprise Server and Cloud
Server for Windows for detailed installation procedures.

If you are upgrading a version of Zen before PSQL v10, the installer archives the previous version
before removing it.

If you are upgrading from much older versions such as Pervasive.SQL 2000; and wish to make
use of newer features, you must rebuild your data files to more recent file formats, depending on
your needs. See Converting Data Files in Advanced Operations Guide for detailed information on
how to use the Rebuild utilities to convert your data files.

An upgrade migrates configuration settings. For a version of Zen before PSQL v10, only the
configuration settings defined in ptksetup.ini are migrated. For PSQL v10 and later versions, an
upgrade disregards any settings defined in ptksetup.ini and simply migrates all configuration
settings.

Note that license keys from a previous release are no longer valid if you upgrade to a new major
release, such as from v15 to v16. You must obtain a new key to authorize it.

Considerations When Upgrading to Zen v16

Once you have reviewed the latest product information, review this list of considerations to
complete your upgrade installation preparation:

O Zen Applications — Be aware of what applications you have currently using previous versions
of Btrieve or Zen in your environment. Remember to include both client and server-based
applications.




Zen Ecosystem Products — Existing installations of AuditMaster, Backup Agent, or
DataExchange working with the version of Zen to be upgraded must first be uninstalled.
Before removing them, we recommend you capture their configuration settings to use in
reinstalling and configuring their new versions after upgrading.

Vendor-Specific Information — Check with your application vendors for any specific
information regarding their product with Zen.

TCP/IP Protocol — Make sure that TCP/IP network is configured correctly (you should be
able to ping the server by name), and that any firewalls between the clients and server

(including firewalls on those computers) are configured to pass database traffic. See Windows
FireWalls.

DOS Requester — DOS applications are supported only via the BTRBOX requester. Migrate
native DOS machines to a Win32 platform before upgrading Zen. BTRBOX and DOS
applications are not supported on 64-bit Windows platforms.

New Features and File Rebuilding — To make use of new features, you may need to rebuild
data files to the newest format version. See the Rebuild utility in Advanced Operations Guide.

Data File Backups — Before upgrading, make sure you have a current backup of your data,
database engine files, and configuration settings.

Common Questions After Upgrading

This topic contains information that you should read after running the installation program. If you
are having problems, see Troubleshooting After Installation or get help online from the
knowledge base at the Actian website.

How to Handle Data Source Names (DSNs)

The following table describes the procedures for upgrading your DSNs after you have installed
the Zen upgrade.

Scenario Discussion

You have existing DSNs created ~ You must delete all existing DSNs before you upgrade. Once you
with a version before have upgraded, recreate the DSNs to access the existing databases.

Pervasive.SQL 2000 SP4 New DSNs should connect to a named database, not to an Engine

DSN because Engine DSNs are deprecated.
See ODBC Connection Strings in ODBC Guide.
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Scenario

Discussion

You have existing DSNs created
with Pervasive.SQL 2000 SP4
or a later version

You can access your databases by connecting to the existing DSNG.

Note, however, the recommendation is that new or revised 32-bit
applications should connect to a named database, not to an Engine
DSN because Engine DSNs are deprecated.

If you want to port your 32-bit application to 64-bit, then make the
following changes.

» Ifthe application uses DSN-less connections that connect using
“Pervasive ODBC Client Interface,” change the connection
string to “Zen ODBC Interface.”

» If the application uses Engine or Client DSNs, you must create
64-bit DSNs that connect to a named database. Also note that on
64-bit Windows operating systems, 64-bit system DSNs are

distinct from 32-bit system DSNs because of the registry design.

See ODBC Connection Strings in ODBC Guide.

You do not have any DSNs
defined

For details about creating DSNs, see DSN Setup and Connection
Strings in ODBC Guide.

If you want to use DSN-less connections for 32-bit applications, use
the connection string “Pervasive ODBC Client Interface” and
connect to a named database. For 64-bit DSNs, use the connection
string “Zen ODBC Interface” to connect to a named database.

How Do | Convert Files from Previous Releases?

Converting older data files to newer formats is not required, but you must convert them if you
wish to take advantage of newer features based on those formats. Use the Rebuild tool to convert
existing pre-6.0 or 6.x files to 7.x, 8.x, 9.x, or 13.x format. For more information, see Advanced

Operations Guide.

What User License Was Installed?

A trial license is installed if you leave the license number blank during installation. A license
requires no configuration. After installation, you can use the License Administrator tool to list
installed licenses. See Zen User’s Guide for more information on License Administrator.
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Installing Zen Enterprise Server and
Cloud Server for Windows

The following topics cover installation of a Zen server:
* Before You Install
* Installing a Zen Server on Windows

*  Where to Go from Here

Before You Install

Before you install any edition of Zen, you should be familiar with the following information:

» Preparing to Install Zen - Important information, including system requirements and platform

specific notes, relevant to your operation.

* Release Notes - The release notes are located in readme zen.htm on the distribution media
and contain late-breaking news that could not be included in the user documentation.

Platform Notes

To install Zen on Windows, you must have administrator rights.

Installing the Engine on Terminal Server

To install on a terminal server, you must be logged on to the console of the server as a user with
system administrator rights to install. This can either be the physical console on the server or a
remote console session.

Install as you normally would, using the steps in the documentation. The operating system
automatically handles the changing of terminal server modes.
Running the Engine on Terminal Server

Only one instance of the database engine may run on any terminal server platform. You cannot
run separate copies of the database engine within two or more terminal sessions.

23



Installation Tips

*  When installing for the first time on a system, the installer checks whether all needed system
files meet minimum requirements. In some cases, these files are locked by the operating
system and a restart is required before the installer can continue.

Caution! You must restart your system if you encounter the restart message. If you do not restart
your system, the installer encounters failures during engine and utility configuration.

» If you have any trouble with the following installation, see Troubleshooting After Installation.

Failover Clusters

If you plan to install Zen in a clustered environment using Microsoft Cluster Service (MSCS), you
should first refer to High Availability Support in Advanced Operations Guide. This topic provides
instructions for installing or patching Zen in a clustering environment.

Installing a Zen Server on Windows

You must install Zen Enterprise Server or Cloud Server locally on the Windows server itself. You
cannot install it remotely from a client machine.

After you run the installer, you can find the installation log file in the Windows %Temp%
directory. This log may be useful if the installation fails.

To install on Windows

1. Launch the installer from your Windows machine in one of the following ways:
* Download and run the installer.

» Insert the installation CD into the CD-ROM drive. If the installer does not start
automatically, then open the CD root directory and run autorun.exe.

2. In the installer selection list, click Enterprise Server or Cloud Server to install the
components appropriate for your 32- or 64-bit Windows system.

3. If prompted, close or uninstall any running applications that may interfere with Zen
installation. If you wish to leave any of these programs running, you must click Ignore to
continue. However, unpredictable behavior may occur during Zen installation that causes it to
fail.

4. Inthe Welcome screen, click Next.
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On the License Agreement page, read and accept the Software License Agreement, then click
Next.

Select one of the following setups:

* Complete setup is recommended for most users. It installs all Zen components using the
default options and locations. If you choose this setup, click Next and continue with step
11.

+ Custom setup is for advanced users. It allows you to choose installation locations and
control the number of Zen components installed. If you choose Custom, continue with the
next step.

To choose different installation locations, click Change for any of the directories listed. When
you have made your choices, click OK.

Click Next to continue.

By default, all Zen components and features are selected for installation. If needed, select
from the following items to exclude them from installation and click Next.

Data Access
* ADO.NET Providers
» Btrieve DOS (32-bit only)

« DTO/DTI

- JCL

» JDBC Driver
« PDAC
Utilities

+ Java Utilities
* Zen Control Center (ZenCC)
* Documentation plug-in for ZenCC
» Data Dictionary File Builder
* Notification Viewer
»  Other Utilities
* Cobol Schema Executor

* Zen System Analyzer
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10.
11.

12.

13.

14.

15.

Click Next to continue.
Click Install to begin the installation.

Once the installation is complete, the wizard indicates that it was successful. The product has
been installed with a trial key that expires at the end of its trial period.

You have two choices at this point: continue and authorize the product with a permanent key,
or end the installation (and later authorize the product with a permanent key).

» If you choose to continue and authorize the product, an Internet connection is required.
Click Next and continue with the next step. If you have no Internet connection, click Next
and then click Finish, then see Alternative Authorization Tasks in Zen User’s Guide.

» If you choose to end the installation at this point, click Next and then click Finish. You
may run the License Administrator utility at a later time to authorize a key. See License
Administration in Zen User’s Guide.

Enter your license key and click the button to authorize the key.

If you decide not to authorize the product at this point, click Finish. You may run the License
Administrator utility at a later time to authorize a key. See License Administration in Zen
User’s Guide.

A message box displays the status of the authorization action. Perform one of the following
actions depending on the status:

» If the authorization status message is “key is authorized,” click OK, then click Finish to
complete the installation.

» If the authorization status message reports an error or warning, click OK, and repeat the
step to enter a valid license key.

We recommend that you register your product as explained in the Registration page that
opens.

If you are prompted to restart your system, please do so to ensure proper operation of your
installation.

Note: The installer modifies selected environment variables.

Where to Go from Here

A proper configuration is essential for smooth operation of your Zen server. See Setting Up
Network Communications for Servers for detailed information on how to do this task.
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Installing Zen Clients for Windows

The following topics cover Zen Client installation:
* Before You Install the Windows Client

* Installing Zen Client for Windows

» Installing the BTRBOX Requester

¢ Understanding Client Requesters

*  Where to Go from Here

Before You Install the Windows Client

Before you install any edition of the database, you should be familiar with the following
information:

* Preparing to Install Zen — Important information, including system requirements and platform
specific notes, relevant to your operation.

* Release Notes — The release notes are located in readme zen.htm on the distribution media
and contain late-breaking news that could not be included in the user documentation.

Installing Zen Client for Windows

Zen Client is installed by default with Zen Enterprise Server, Cloud Server, and Workgroup. You
can also install it on a client system. After the installer runs, the installation log file is in the
Windows %Temp% directory. This log may be useful if the installation fails.

Note: See also Does the Zen Client version have to match the Zen Server version?

To install Zen Client for Windows

1. Launch the Zen installer from your Windows machine in one of the following ways:
* Download and run the installer.

 Insert the installation CD into the CD-ROM drive. If the installer does not start
automatically, then open the CD root directory and run autorun.exe.

2. Inthe installer selection list, click Client Only to install the components appropriate for your
32- or 64-bit Windows system.
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If prompted, close or uninstall any running applications that may interfere with Zen
installation. If you wish to leave any of these programs running, you must click Ignore to

continue. However, unpredictable behavior may occur during Zen installation that cause it to
fail.

In the Welcome screen, click Next.

Choose the type of installation:
» Select the default Run as a Service if either or both of the following is true:
* You want to run Client Cache Engine when the machine starts.

* You will run Client Cache Engine in a Terminal Services or multiuser environment
with fast user switching.

* Select Run as an Application if:

You will run Client Cache Engine only as needed. After it starts, an icon in the notification
area at the far right of the taskbar allows you to manage engine caching.

Note: Running Client as a service requires the Log On as Service privilege. If you select to run
it as a service under a user account other than the default local system account, be sure to modify
the Log On Properties for the Service in the Windows Control Panel. If installed as a service, the
Client cache is set by default to start automatically. However, even though the Client cache

service is running, an application does not use the cache unless its configuration setting is
enabled.

7.

The Client Cache Engine is a specialized version of the MicroKernel Engine that caches read-
only data and runs as a separate process. By default, whether installed as a service or as an
application, use of the Client Cache Engine is disabled. Disabling it means that nothing is
cached on the client side. Read requests from an application retrieve data from the remote
database engine. Enabling the cache engine means that it acts as an intermediary cache
between the client and the remote database.

See the Use Cache Engine property in Advanced Operations Guide.

On the License Agreement page, read and accept the Software License Agreement, then click
Next.

Select one of the following setups:

* Complete setup is recommended for most users. It installs all Zen components using the

default options and locations. If you choose this setup, click Next and continue with step
12.
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» Custom setup is for advanced users. It allows you to choose installation locations and
control the number of Zen components installed. If you choose Custom, continue with the
next step.

8. To choose different installation locations, click Change for any of the directories listed. When
you have made your choices, click OK.

9. Click Next to continue.

10. By default, all Zen components and features are selected for installation. If needed, select
from the following items to exclude them from installation and click Next.

e Data Access
« ADO.NET Providers
* Btrieve DOS (32-bit only)

« DTO/DTI

- JCL

+ JDBC Driver
« PDAC

» Utilities
» Java Utilities
» Zen Control Center (ZenCC)
* Documentation plug-in for ZenCC
* DDF Builder
»  Other Utilities
* Cobol Schema Executor
* Zen System Analyzer
11. Click Next to continue.

12. Click Install to begin the installation.

13. Once the installation is complete, the wizard indicates whether it was successful. Click
Finish.

If you are prompted to restart your system, please do so for proper operation of the product.

Note: The installer modifies selected system environment variables.
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Installing the BTRBOX Requester

The Zen database engine supports DOS Btrieve applications with the BTRBOX requester for
Windows platforms. Use this requester for legacy DOS applications.

A separate installation is no longer needed for the DOS Requester. The DOS Requester is
automatically installed during a complete Zen engine installation. In the case of a custom
installation, you must select the Btrieve DOS optional feature in the Zen Access Methods group to
install the DOS Requester.

Note: Clients using the DOS operating system will have only transactional access to the data
files. No relational access is available for this platform.

Win32 DOS Box Support

BTRBOX allows a DOS application to run in a DOS box on a Windows workstation. This enables
direct communication with Windows 32-bit workstation components rather than with the database
engine. This configuration can be used with either a local Workgroup engine or a remote Zen
server engine. The TCP/IP protocol supported for client-server access depends on the
configuration of the Windows 32-bit components.

DOS applications are not supported on 64-bit Windows platforms. Therefore, BTRBOX is not
supported on 64-bit Windows platforms.

Understanding Client Requesters

A workstation that needs to access database files is considered a client to the machine running the
Zen server. A piece of software called a client requester, or requester for short, is required to
access database files from a Zen database server. Your application calls the Zen server through the
requester, which sends them to the server for processing and then returns the reply to your
application.

See the Zen release notes for a list of the platforms where Zen requesters are supported. The
requesters use the TCP protocol to communicate with the server MicroKernel, depending on the
type of server you have. Ensure that your workstation has the appropriate network protocol
software installed.

Note: Clients using DOS operating systems will have only transactional access to the data files.
No relational access is available for this platform.
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Types of Windows Requesters

Zen includes the following types of requesters for Windows:
+ DOS

* Trace

You do not load or unload the Requester explicitly; the system loads the Requester with the first
application call to Zen and unloads the Requester when you exit your application.

DOS Requesters

This type of requester is used for applications that run under the DOS operating system.

Trace Requesters

Trace requesters are used for troubleshooting (tracing) client problems at a low level. Generally,
you will never need to perform this type of tracing. The low-level tracing is intended for use by
trained support staff. Your product vendor or Zen Support will direct you on how to conduct low-
level client tracing, which includes how to use the trace requesters.

Note that the tools provided with Zen solve most troubleshooting issues. For example, you would
run the network connectivity tests in Zen System Analyzer to verify network connectivity. Also at
your disposal is the knowledge base at the Actian website, through which you may search for
information about particular client issues.

Where to Go from Here

A proper configuration is essential to smooth operation of your Zen Client. See Setting Up
Network Communications for Clients for detailed information on how to do this task.
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Installing Zen Workgroup for Windows

The following topics cover installation of Zen Workgroup:
» Before You Install Workgroup
* Installing Zen Workgroup for Windows

*  Where to Go from Here

Before You Install Workgroup

Before you install any edition of Zen, you should be familiar with the following information:

* Preparing to Install Zen — Important information including system requirements and platform
specific notes that are relevant to your operation.

* Release Notes — The release notes are located in readme_zen.htm on the distribution media
and contain late-breaking news that could not be included in the user documentation.

Installation Tips

*  When installing Zen for the first time on a system, the installer checks whether all needed
system files meet minimum requirements. In some cases, these files are locked by the
operating system and a restart is required before the installer can continue. Click Yes to restart
the system. The installer is then automatically restarted.

» Itis strongly recommended that you restart your system if you encounter this message. If you
do not restart your system, the installer encounters failures during engine and utilities
configuration.

» Ifyou have any trouble with the following installation, see Troubleshooting After Installation.

Installing Zen Workgroup for Windows

The following steps explain how to install Workgroup from its media using the default interactive
installation.

After you run the installer, you can find the installation log file in the Windows %Temp%
directory. This log may be useful if the installation fails.
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To install Zen Workgroup for Windows

1.

Launch the Zen installer from your Windows machine in one of the following ways:
* Download and run the installer.

* Insert the Zen CD into the CD-ROM drive. If the installer does not start automatically,
then open the CD root directory and run autorun.exe.

In the installer selection list, click Workgroup Edition to install its 32-bit components.

If prompted, close or uninstall any running applications that may interfere with Zen
installation. If you wish to leave any of these programs running, you must click Ignore to
continue. However, unpredictable behavior may occur during Zen installation that cause it to
fail.

In the Welcome screen, click Next.

On the License Agreement page, read and accept the Software License Agreement, and then
click Next.

Choose the type of installation:
» Select the default Run as a Service if either or both of the following is true:

*  You want to avoid User Access Control (UAC) conflicts in the operating system.
Running the engine as a service requires the Log On as Service privilege. If you run
the engine as a service under a user account other than the default Local System, in the
Windows Services control panel in the properties for the Actian Zen Workgroup
Engine service, be sure to set the account login in the Log On tab.

*  You want to run Workgroup Engine in a Terminal Services environment.
* Select Run as an Application if:

The data files reside on a remote machine, are accessed via mapped drives, and no
database engine is running on the remote machine.

Select one of the following setups:

* Complete setup is recommended for most users. It installs all Zen components using the
default options and locations. If you choose this setup, click Next and continue with step
12.

+ Custom setup is for advanced users. It allows you to choose installation locations and
control the number of Zen components installed. If you choose Custom, continue with the
next step.
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10.

I1.
12.
13.

To choose different installation locations, click Change for any of the directories listed. When

you have made your choices, click OK.

Click Next to continue.

By default, all Zen components and features are selected for installation. If needed, select
from the following list the items to exclude from installation and click Next.

Data Access
« ADO.NET Providers
» Btrieve DOS (32-bit only)

« DTO/DTI

- JCL

+ JDBC Driver
« PDAC
Utilities

» Java Utilities
» Zen Control Center (ZenCC)
* Documentation plug-in for ZenCC
* Data Dictionary File Builder
* Notification Viewer
* Other Utilities
* Cobol Schema Executor

* Zen System Analyzer
Click Next to continue.

Click Install to begin the installation.

Once the installation is complete, the wizard indicates that it was successful. The product has

been installed with a trial key that expires at the end of its trial period.

You have two choices at this point: Authorize the product now with a permanent key or end
the installation and authorize the product later.

» Ifyou choose to authorize the product now, an Internet connection is required. Click Next

and continue with the next step. If you have no Internet connection, click Next and then
click Finish. See Alternative Authorization Tasks in Zen User’s Guide.
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14.

15.

16.

» Ifyou choose to end the installation at this point, click Next and then click Finish. You
may run the License Administrator utility at any time to authorize a key. See License
Administration in Zen User’s Guide. See also Authorization of Workgroup Key on
Windows with UAC.

Enter your license key and click the button to authorize the key.

If you decide not to authorize the product at this point, click Finish. You may run the License
Administrator utility at a later time to authorize a key. See License Administration in Zen
User’s Guide.

A message box displays the status of the authorization action. Perform one of the following
actions depending on the status:

» If the authorization status message is “key is authorized,” click OK, then click Finish to
complete the installation.

» If the authorization status message reports an error or warning, click OK and repeat the
step to enter a valid license key.

We recommend that you register your product as explained in the Registration page that
opens.

If you are prompted to restart your system, please do so to ensure proper operation of your
Zen product.

Note: The installer modifies selected system environment variables.

Authorization of Workgroup Key on Windows with UAC

You can encounter difficulty authorizing a permanent key for Zen Workgroup on Windows with
User Account Control (UAC) if the following conditions are all true:

Zen Workgroup was installed as an application.

The Workgroup database engine is running without administrative privileges. Note that, by
default, applications run with privileges of a standard user unless the privileges are elevated.
That is, even if you are a member of the administrator group and you start the Workgroup
database engine without using Run as Administrator to elevate privileges, the engine runs
with privileges of a standard user.

A permanent key for Zen Workgroup was not supplied during the installation process. That is,
you chose to authorize the permanent key after installation by using a licensing utility.

Complete the following steps to ensure a permanent key is correctly authorized:
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6.

. If the Zen Workgroup application is running, close the application (stop the database engine

by right-clicking on the engine tray icon then clicking stop).

From File Explorer, locate the file zenengnapp.exe. In a default 64-bit installation, it is found
in C:\Program Files (x86)\Actian\Zen\bin.

Right-click zenengnapp.exe and select Run as Administrator. You must have administrative
rights or know the name and password of a user with administrative rights. You need to
elevate the privileges of the database engine before authorizing a key with a licensing utility.

Start License Administrator from operating system Start menu or Apps screen (or use the
command line interface licensing utility if you prefer).

Type, or paste, the permanent key for Zen Workgroup in the Key field, then click the button to
authorize the key.

Optionally, stop the database engine and restart it without elevated privileges.

Note that elevating the privileges for a license administrator utility is not the solution. The
database engine itself, zenengnapp.exe, is what requires elevated privileges.

Where to Go from Here

A proper configuration is essential to smooth operation of your Zen Workgroup engine. See
Setting Up a Workgroup Engine for detailed information on how to do this task.
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Installing the Client Reporting Engine for
Windows

The following topics cover installation of a Zen Client Reporting Engine:
* Before You Install the Windows Client Reporting Engine

* Installing Zen Client Reporting Engine for Windows

*  Where to Go from Here

Before You Install the Windows Client Reporting
Engine

Before you install any edition of Zen, you should be familiar with the following information:

* Preparing to Install Zen — Provides important information, including system requirements and
platform specific notes.

* Release Notes — The latest version of the release notes can be downloaded from the Actian
website.

Installing Zen Client Reporting Engine for
Windows

After you run the installer, you can find the installation log file in the Windows %Temp%
directory. This log may be useful if the installation fails.

Note: See also Does the Zen Client version have to match the Zen Server version?

To install Zen Client Reporting Engine for Windows

1. Launch the Zen installer from your Windows machine in one of the following ways:
* Download and run the installer.

* Insert the Zen CD into the CD-ROM drive. If the installer does not start automatically,
then open the CD root directory and run autorun.exe.

2. In the installer selection list, click Client Reporting Engine to install the components
appropriate for your 64-bit Windows system.
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If prompted, close or uninstall any running applications that may interfere with Zen
installation. If you wish to leave any of these programs running, you must click Ignore to

continue. However, unpredictable behavior may occur during Zen installation that cause it to
fail.

In the Welcome screen, click Next.

On the License Agreement page, read and accept the Software License Agreement, then click
Next.

Select one of the following setups:

* Complete setup is recommended for most users. It installs all Zen components using the
default options and locations. If you choose this setup, click Next and continue with step
11.

» Custom setup is for advanced users. It allows you to choose installation locations and
control the number of Zen components installed. If you choose Custom, continue with the
next step.

To choose different installation locations, click Change for any of the directories listed. When
you have made your choices, click OK.

Click Next to continue.

By default, all Zen components and features are selected for installation. If needed, select
from the following items to exclude them from installation and click Next.

Data Access

* ADO.NET Providers
« DTO/DTI

« JCL

« JDBC

« PDAC

Utilities

+ Java Utilities
* Zen Control Center (ZenCC)
* Documentation plug-in for ZenCC
* Data Dictionary File Builder

* Notification Viewer
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* Other Utilities
* Cobol Schema Executor
* Zen System Analyzer
10. Click Next to continue.
11. Click Install to begin the installation.

12. Once the installation is complete, the wizard indicates that it was successful. Click Finish.

If you are prompted to restart your system, please do so to ensure proper operation of your
Zen product.

Note: The installer modifies selected system environment variables.

Where to Go from Here

The Client Reporting Engine does not require a license key. It depends on the license of the Zen
server that you configure it to support.

The Client Reporting Engine must be configured to enable most of its functions. See Setting Up a
Client Reporting Engine for detailed information on how to do this task.
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After Installing Zen for Windows

The following topics cover common questions and steps for removing Zen from your system:
* Common Questions After Installing

e Uninstalling Zen

Common Questions After Installing

This section contains information that you should read after running the installation program. The
questions apply to all of the database engine products unless specific products are mentioned. If
you are having problems with your installation, see Troubleshooting After Installation, or visit the
Actian Community and Customer Portal and select Actian Zen from the product menu to join a
community forum discussion, search for knowledge base topics, or log a support case.

Where are the files installed?

The following table lists the default locations where Zen installs the program and application data
files on Windows platforms. Other platforms are covered under Where Do Files Reside After
Installing Zen on Linux and Raspbian?

Platform File Types Default Installation Location

Windows (64-bit) Zen Application Data <drive:>\ProgramData\Actian\Zen\

Program Files (64-bit) <drive:>\Program Files\Actian\Zen\

Program Files (32-bit) <drive:>\Program Files (x86)\Actian\Zen\

Windows (32-bit) Zen Application Data <drive:>\ProgramData\Actian\Zen\

Program Files <drive:>\Program Files\Actian\Zen\

Note: The DOS Requester files are installed by default only on 32-bit Windows platforms at
<drive:>\%WINDIR%\SYSTEM32\

What is an application data file?

Application data files are typically files to which the system can write. Examples of application
data files include log files, tutorial files, and sample database files, such as Demodata and tempdb.
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What is a program file?

Program files are typically files the system requires in order to function. Examples of program
files include binary system files, executable files, dynamic link libraries and .jar files.

What is the difference between 32- and 64-bit program files?

Microsoft guidelines recommend that 64-bit components are installed in a separate location from
32-bit components. Zen 64-bit components are installed in the 64-bit program files location and
are registered in the Windows Registry under the 64-bit hive. Zen 32-bit components are installed
in the 32-bit program files location and are registered in the Windows Registry under the 32-bit
(x86) hive.

What if | need a 64-bit Client in a Workgroup environment?
The Workgroup installer installs all components appropriate to your 32- or 64-bit Windows
system. No additional installation is required.

Do I need to install the Client with Workgroup?

If you are installing ZenWorkgroup, you must have a license for it and install the software on
every computer that is expected to share data within your workgroup. Because every computer
must have Workgroup installed and the client software is installed with every engine by default,
there is no need to install the client software separately.

How do | read the online documentation?

The viewer for the documentation library is integrated into Zen Control Center (ZenCC). Access
the documentation library in the ZenCC window on the Welcome tab, in the Help menu, by
pressing F1 (Windows) or Shift F1 (Linux).

You can also view the documentation in the form of Adobe Acrobat (PDF) files. These PDF files
are available in the Zen installation media in the Books directory.

How do I verify or update my user license?

Licenses from previous versions of Zen are neither migrated nor transferable to a new release.
You must have a license applicable for this release, unless you choose to install a trial version of
the product.

The License Administrator utility allows you to view and adjust the keys used to license the Zen
products. For example, you can verify which keys have been authorized, check the state of a key,
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and check the number of authorizations remaining for a key. For a detailed discussion of the
License Administrator utility, and a list of the tasks that you can perform, see License
Administration in Zen User’s Guide.

What user license was installed?
A trial license is installed if you leave the license number blank during installation.

There is no configuration necessary for the license. After installation, you can use the License
Administrator utility to view your installed licenses. See Zen User’s Guide for more information
on this utility.

Where to Go from Here

If you had trouble during installation or have questions regarding troubleshooting, see
Troubleshooting After Installation.

If you completed installation successfully, continue with your Zen deployment by installing and
configuring the clients for the machines that will connect to your servers. For more information,
see Installing Zen Clients for Windows.

Uninstalling Zen

The uninstall program removes the Zen and all related components from your system that were
added by the installation program, including registry settings, configurations and Zen system and
sample databases.

The uninstall program does not remove the following:

» Zen keys

» Databases that you create under the Zen installation directories

* DSNs and database names associated with those databases

» Databases in locations other than the installation directory for Zen installation directory

»  Other products related to Zen such as AuditMaster, Backup Agent, or DataExchange. Such
programs have their own uninstall programs. Refer to the documentation for each product.
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To uninstall Zen

1. Use a Zen license utility (GUI or CLI) to deauthorize the key that was used to authorize the
product. This allows you to use the key for a different installation if you so choose. See To
Deauthorize a Key in Zen User’s Guide, for example.

2. In the Windows Control Panel, select Programs and Features.
3. Select the installed Zen product from the list.
4. Click Change then Next.

5. Click Remove then Next and follow any prompts during the uninstall.
If prompted, close or uninstall any running applications that may interfere with uninstalling
Zen.

Caution! Unpredictable results may occur during the uninstall if you ignore programs that may

interfere.

Restart your system if prompted to do so.
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Setting Up Network Communications for
Servers

The following topics cover the type of network communication supported by Zen.
* Engine Network Communication Settings

» Setting Up TCP/IP Support

Engine Network Communication Settings

This section lists the configuration settings used by the Zen engines for network communication.
These settings may be changed using a command line utility or from within ZenCC on the engine
properties.

The Advanced Operations Guide provides detailed information about each of the settings. See the
following configuration settings in Advanced Operations Guide for network communication:

* Auto Reconnect Timeout

* Enable Auto Reconnect (Windows only)
* Listen IP Address

*  Supported Protocols

» TCP/IP Multihomed

 TCP/IP Port

Setting Up TCP/IP Support

By default, TCP/IP is supported between Zen clients and remote database engines or between
multiple Workgroup engines. If you have modified the default settings or need to verify that TCP/
IP support is available, refer to this section.

Note: To perform any of the tasks in this section, you must have full administrator-level rights on
the machine where the database engine is running, or be a member of the Zen Admin group
defined on the machine where the database engine is running.

47



To Enable TCP/IP Support

Complete the following steps to ensure that the database engine can communicate with clients
over TCP/IP networks.

1. Access Control Center (ZenCC) from the operating system Start menu or Apps screen.
2. In Explorer, double-click Engines to display a list of the engines registered with ZenCC.
3. Right-click the target engine and click Properties. Log in if prompted.

4. Click Communication Protocols, and the list of Supported protocols displays. If the list of
Supported protocols shows the value TCP/IP checked, then TCP/IP is already supported.

5. Click TCP/IP then restart the database engine for the changes to take effect.

Tip... Remember that you also need to confirm that your client computers or the client software
on your other Workgroup computers are configured to use TCP/IP, as well. See Setting Up
Network Communications for Clients.

To Enable Multihomed TCP/IP Support

Completing the following steps configures your Windows server to use two installed network
cards.

1. Access Control Center (ZenCC) from the operating system Start menu or Apps screen.
2. In Explorer, double-click Engines to display the list of registered engines with ZenCC.
3. Right-click the target engine and click Properties. Log in if prompted.

4. Click Communication Protocols and click TCP/IP Multihomed to configure the server
engine to listen for client connections on multiple network interfaces.

If you only have one network interface, this setting is ignored.

5. Restart the server engine for the changes to take effect. You do not need to make any changes
to client settings.

Note: If your server computer has two network interfaces, and you set the value of TCP/IP
Multihomed to Off, you must edit the setting Listen [P Address and specify the TCP/IP address of
the interface on which you want the database engine to listen.

If you do not specify an IP address, the database engine will receive communications only from
the first network interface to bind to the operating system. Because this can vary with driver

48



installation, a working system can easily break after receiving driver updates. To avoid this
problem, always set Listen [P Address.
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Setting Up Network Communications for
Clients

To access network files from a machine where a Zen application is running, you must use an
appropriate client requester on that machine. Zen calls made by your application go through the
client requester, which sends them to the server and then passes the reply to your application.

Generally, the default property settings for Zen server and its clients are sufficient to enable them
to communicate and function correctly. You typically do not have to change any properties, but if
other settings are needed, they are covered in the following topics:

* Client Network Communication Settings

* Network Path Formats Supported by Zen Requesters

 [Pv6

» Using TCP/IP to Connect to a Windows Server

¢ Changing the Default Communication Ports

» Using TCP/IP to Connect a Windows Client to Linux or Raspbian Servers
« Data Encoding

» Using the DOS Requester

* DOS Box Support on Windows

Client Network Communication Settings

This topic lists the configuration settings used by the Zen Client for network communication.
These settings may be changed using a command line utility or from within ZenCC on the engine
properties.

The Advanced Operations Guide provides detailed information about each of the settings. See the
following configuration settings in Advanced Operations Guide for network communication:

* Enable Auto Reconnect (Windows only)
» Supported Protocols

e Connection Timeout




Network Path Formats Supported by Zen
Requesters

When using your Requester, you connect to the Zen database engine to access data files. This
topic covers variations in network file syntax to access files on your network using Btrieve or DTI
applications.

Zen supports the Universal Naming Convention (UNC) and Drive path formats (explicit and
current) across the majority of operating environments.

For more information on the path formats, see the following items:
* Universal Naming Convention (UNC) Path Formats
* Drive-based Formats

* Linux and Raspbian Path Formats

If you are an application developer, also note that the certain access methods, such as the Btrieve
API, support URI connection strings. For details about URI strings, see Database URIs in Zen
Programmer’s Guide. In Btrieve API Guide, see Create (14), Open (0), and Login/Logout (78).

Universal Naming Convention (UNC) Path Formats
The following UNC path formats are supported on all clients to all servers:
\\ServerName or IP address\share\path\file

\\ServerName or IP address\share:[\]path\file

UNC syntax is resolved correctly regardless of the actual type of network operating system
(NOS) running on the target server. If you use an IP address, it must be a dotted IPv4 address or
one of the two formats supported for IPv6. See [Pv6 Addresses.

Note: In all instances above, backslashes (\) can be interchanged with forward slashes (/) except
for the double backslash (\\). The syntax [\] indicates that the backslash is optional.

Drive-based Formats

The following drive representations are supported on all clients to all servers:

drive:file
drive:[\]path\file
file
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[\]path\file
..\file

Linux and Raspbian Path Formats

Incoming paths on a Linux or Raspbian server using Samba are processed as follows in order of
relative priority:

Share Names

\\server\sharename\path

The smb.conf file must be configured to accept the share name, or otherwise it will default to an
absolute path as described in the next topic.

Absolute Paths

\\server\absolute_path

If the smb.conf file is not configured properly or not found on the target server, the absolute path
is used.

For more information on the Linux and Raspbian editions of Zen, see Using Zen on Linux and
Raspbian.

IPvG

A Zen Client using any of the access methods supported by Zen connects using IPv6 to an [Pv6
host running the Zen database engine the same way as it does for IPv4. That is, the client specifies
a server and connects through one of the supported access methods. The server can be either the
name or I[P address of the machine running Zen Enterprise Server, Cloud Server, or Workgroup.

All of the Zen access methods support IPv6 connections. Some access methods are Windows
only, but they can be used with a client-server combination of Windows and Linux or Raspbian.

This topic addresses the following aspects of [Pv6:
» IPv6 Addresses

* [Pv6 and the MicroKernel Engine

* IPv6 and the Relational Engine

* [Pv6 with Linux and Raspbian
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» Frequently Asked Questions About IPv6

IPv6 Addresses

Raw IPv6 addresses can be written as 8 colon-separated segments where each segment is a 4-digit
hexadecimal value. For example, 1234:5678:90ab:cdef:1234:5678:90ab:cdef. Within this
framework, several forms of [Pv6 names are possible.

Recommendations for Numeric IPv6 Addresses

In general, numeric IPv6 addresses are more complex and difficult to manipulate than [Pv4
addresses. Numeric Link Local addresses are notably problematic, especially with regard to Zone
IDs.

For that reason, we recommend the use of host names through DNS servers, LLMNR, host files,
or other means of address resolution, particularly for production environments. Zen support for
numeric IPv6 addresses is intended mainly for development environments. Because many
contexts require square brackets for [IPv6 numeric addresses, when in doubt, add them if numeric
addresses are necessary.

Unicast Addresses

Zen supports only unicast addresses. The following are the [Pv6 unicast address formats that can
be used with Zen.

Unicast Description

Address

Format

Loopback The local loopback address, which in IPv6 is 0:0:0:0:0:0:0:1. The loopback address can

be abbreviated to ::1.
The IPv6 loopback address is equivalent to the IPv4 loopback address of 127.0.0.1.

Global Global addresses have a 64-bit prefix where the first 3 bits are always 001, the next 45
bits are set to the global routing prefix, the next 16 bits are set to the subnet ID and the
last 64-bits are the interface ID.

Example: 2001:db8:28:3:f98a:5b31:67b7:67¢f
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Unicast Description
Address
Format

Link Local Link Local addresses are used by nodes when communicating with neighboring nodes
on the same link. Link Local addresses have a 64-bit prefix where the first 10 bits are
setto 1111 1110 10, the next 54 bits are set to 0 and the last 64 bits are the interface ID.
The link local prefix is often represented as FE80::/64.

Example: f€80:0:0:0:713¢:a426:d167:37ab (which may also be specified as
fe80::713e:a426:d167:37ab)

See also [Pv6 and the MicroKernel Engine.

IPv6 Address Modifiers

IPv6 includes address modifiers that can act as shortcuts or can specify the destination in more
detail. Zen supports the following ones for IPv6.

Modifier Explanation

Represents one or more colon-separated zeroes. For example, ::1 is equivalent to
0:0:0:0:0:0:0:0:1. The :: modifier can be used only once within an IPv6 address.

% Represents the Zone ID or interface of a destination node. On Windows, a Zone ID is an
integer that specifies the zone of the destination for IPv6 traffic. Zone IDs are primarily
used with Link Local addresses to disambiguate those addresses.

Unix distributions support only the text form of a Zone ID in a link local address. For
example, you must use the "eth0" form of a Zone ID: eth0
£€80:0:0:0:713e:a426:d167:37ab. See also Limitations and Conditions.

See IPv6 and the MicroKernel Engine.

Address Presentations

Zen supports [Pv6-literal.net names on Windows and bracketed IPv6 addresses on Windows,
Linux and Raspbian.

IPv6-literal.net Names
An ipv6-literal.net name is a raw IPv6 address with three changes:
* The colon ":" is replaced with a hyphen "-".

* The percent sign "%" is replaced with the letter "s".

» The whole address is appended with ".ipv6-literal.net".
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Examples

Initial Addresses fe80::713e:a426:d167:37ab%4
2001:db8:28:3:198a:5b31:67b7:67ef

Modified Addresses fe80--713e-a426-d167-37abs4.ipv6-literal.net
2001-db8-28-3-f98a-5b31-67b7-67ef.ipv6-literal.net

Note: Linux and Raspbian distributions do not support [Pv6-literal.net names.

Bracketed IPv6 Addresses

A bracketed IPv6 address is a raw [Pv6 address with square brackets around it. This format is also
referred to as a Uniform Naming Convention (UNC)-safe address.

Examples

Initial Addresses fe80::713e:a426:d167:37ab%4
2001:db8:28:3:198a:5b31:67b7:67ef

Modified Addresses [fe80::713e:a426:d167:37ab%4]
[2001:db8:28:3:198a:5b31:67b7:67¢f]

Note: Linux and Raspbian distributions do not natively support UNC paths and UNC-safe
addresses. However, the Zen interfaces that accept a file path, a numeric address, or both as input
support both UNC paths and UNC-safe addresses on Linux and Raspbian for compatibility with
Windows.

IPv6 and the MicroKernel Engine

The following table lists the restrictions on the use of IPv6 with the MicroKernel Engine.

Restriction Discussion

The Zen server engine in The engine is supported in an IPv6-only environment on Windows Vista
an [Pv6-only environment  and later operating systems, and in [Pv6-only environments on the most
current Linux and Raspbian distributions.

UNC paths do not allow Avoid raw IPv6 addresses. Wherever possible, use host names. See
certain special characters,  Address Presentations and Recommendations for Numeric [Pv6
such as colons, that are Addresses.

part of IPv6 addresses
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Restriction

Discussion

Square brackets are
required for raw IPv6
addresses when the
address is used in a URI or
UNC

Raw IPv6 addresses, abbreviated or not, must be enclosed by square
brackets if the address is used in a URI or UNC.

Examples:

o Dbtrv://czjones@[2001:b1::23]/demodata

* btrv://abanderas@][2001:12:34:56:78:90:12:23]/demodata
* \\[2001:12:34:56:78:90:12:23\acctsvr1\Domestic\file.mkd

Failure to bracket the IPv6 address results in status code 3014 or 3103 for
Btrieve calls using a URI, or status code 11, 94, or 170 for Btrieve calls
using a UNC.

In a URI, if you include a
ZonelD to a server
address, the "%" ZonelD
character must be escaped
with "%25"

If you use a btrv:// connection with an IPv6 address, you must escape the
ZonelD for the host name. Zone IDs are usually required with IPv6 Link
Local numeric addresses.

Example:

A UNC-safe addresses like
btrv://@[fe80::20c:291f:fe67:2ee4%4]
must be changed to
btrv://@[fe80::20c:291f:fe67:2ee4%254]

Operating system
limitations

See Limitations and Conditions.

IPv6 and the Relational Engine

The inclusion of a port number with an IP address is necessary only when you need to override
the default port. Generally, a port number can be appended to an IP address using either a colon
(:port number) or a dot (.port number).

UNC-safe names (see Address Presentations) support the appending of a port number.

IPv6 with Linux and Raspbian

All of the previous topics about IPv6 apply to Linux and Raspbian distributions, with specifics
noted. The following topics discuss additional aspects of IPv6 when used with Linux and

Raspbian.

Suggested Distributions

Full IPv6 support is a relatively recent feature of operating systems. For this reason, we
recommend that you use the most current Linux or Raspbian distribution. See the Actian website
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for a list of the Linux and Raspbian distributions and use the most current distribution of the latest
one listed.

Limitations and Conditions

Note the following limitations and conditions when you use IPv6 with Linux or Raspbian:

* Ping commands are specific for IPv4 (ping) and IPv6 (ping6). If you use ping6 with a Link
Local address, the Zone ID is a separate argument, not a part of the address. For example,
"eth0" is the Zone ID in the following ping6 command: pingé -I ethe
fe80::1574:833f:b328:30ab

* As previously mentioned, Zen interfaces running on Unix-based systems support UNC paths
and UNC-safe addresses, even though Unix itself does not. This could be a source of
confusion when you perform operations at the operating system level. For example, assume
that you receive a network error when you run the following command for butil:

butil -stat //[fe80::1574:833f:b328:30ab%eth@]/DemodataShare/billing.mkd.

You may attempt to diagnose the error with commands such as the following:

ping [fe80::1574:833f:b328:30ab%eth0]
ping6 [fe80::1574:833f:b328:30ab%eth0]
ping6 fe80::1574:833f:b328:30ab%etho

However, all of those commands fail with "unknown host" or "invalid argument" because of
the brackets in the address, the appended Zone ID, or both. You must use the following
command to determine if the network connection actually exists:

ping6 -I etho fe80::1574:833f:b328:30ab .

* The mount command does not accept a Zone ID with an IPv6 numeric address. A Link Local
address cannot be used with mount. You can use a host name that resolves to an IPv6 address.

Best Practices
We recommend the following practice when you use IPv6 with Linux or Raspbian.

Use pvnetpass to ensure that the Zen Client platform provides the required credentials on a server
when the client connects to the database engine on that server. Pvnetpass is required for each
different server address connection, even equivalent server addresses. For example, suppose that a
host name and an IPv6 numeric address refer to the same server. A connection to each one
requires the use of pvnetpass. See pvnetpass in Zen User’s Guide.
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Frequently Asked Questions About IPv6

The following table answers some frequently asked questions about IPv6 support and Zen.

Question

Answer

Does a network environment that
includes both IPv4 and IPv6 affect
Zen user counts?

No. IPv4 and IPv6 are just different address formats of TCP/IP.

Because a Zen client can have both
IPv4 and IPv6 addresses, will
confusion result over how many
licenses are required?

No. This is not a new situation. In the past, clients have
sometimes had more than one [Pv4 address. Zen handles the
situation by recognizing all of the addresses of a machine to
identify it and also follows the same logic for multiple addresses
using more than one IP version.

Any restrictions with [Pv6 and the
use of License Administrator?

Yes. The Zen licensing server does not yet support [Pv6. Because
of this, you can use License Administrator over [Pv6 to
administer licenses. However, to authorize a license with License
Administrator, the utility must be running on a machine that uses
IPv4 to communicate with the Zen licensing server.

Does the use of IPv6 change the
use of DSNs?

No, continue to use DSNs as usual. You can use IPv6 numeric
address, with or without brackets, when creating DSNs. See DSN
Setup and Connection Strings in ODBC Guide.

Can Zen System Analyzer still test
connections?

Yes, you can test [Pv6 addresses. The transaction engine test
requires a mapped drive or a UNC path to the samples folder. An
[Pv6 numeric address used in a UNC path must include brackets.
See Zen System Analyzer (ZenSA) in Zen User’s Guide.

Can Zen User’s GuideAuto
Reconnect be used with IPv6?

Yes. See Auto Reconnect in Advanced Operations Guide.

Does Zen support IPv6 in virtual
machine environments?

Yes.

Can the Listen I[P Address
configuration setting be set to
multiple addresses?

Yes. See Listen [P Address in Advanced Operations Guide.

Which GUI utilities support [Pv6?

DDF Builder, Function Executor, License Administrator,
Monitor, ZenCC, System Analyzer, and Rebuild.!

Which CLI utilities support IPv6?!

Befg, bmon, butil, clilcadm, clilcadm64, pvdbpass, pvddi,
pvnetpass, rbldcli,” and wé4clilcadm.
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Question Answer

! Some utilities accept UNC path formats that are not valid for the operating system, file system, or file
sharing protocol.

2 Rbldcli must have direct file access for proper operation. Any file paths specified in a rbldcli
command must also be accessible through the file system or through a file sharing protocol such as
Windows File Sharing or Samba. One method of verifying valid paths is to check whether they work
with operating system commands such as dir or Is.

Using TCP/IP to Connect to a Windows Server

This section documents the use of TCP/IP when connecting to a Zen server running on a
Windows server platform.

Configuring a Client for the Server IP Address

When Zen operates in a TCP/IP network, your client must be able to obtain the IP address of your
Windows server from the name given to that server. There are two mechanisms that enable this
address-to-name translation:

* DNS (Domain Naming Service)
» Editing the hosts file

The following procedures provide an overview for how to set up the IP address using each
method. For details about network configuration and set up, refer to the documentation for the
operating system.

Using DNS to Configure the Server IP Address

When you use DNS, you specify settings that allow your computer to look up the address of the
server in a database of servers. Your network administrator can provide the information you need
to configure DNS.

To configure your Windows clients to use DNS to resolve the server IP address

1. From the operating system, access the Network information.

2. Select the Properties for Local Area Connection.

3. Select the Properties of the TCP/IP connection being used (IPv4 or IPv6, for example).

4. Enable DNS and enter the appropriate server information.
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Using the Hosts File to Configure the Server IP Address

The hosts file is a way to manually enter a relationship between a name and an IP address. Use
this method if DNS is not used in your organization.
To edit the hosts file on your Windows client

1. Find the hosts file on your Windows machine.

For example, on certain Windows platforms it is located here:
SWINDIR%\SYSTEM32\DRIVERS\ETC\HOSTS

2. Edit the hosts file with a text editor such as Notepad.

3. Enter your server IP address and name in the hosts file as a new line as shown in the following
example. Your network administrator can provide you with the IP address.

# the following is an example of a hosts file entry for IPv4 address

146.23.45.2 acctserver

Preventing the Windows Dial-Up Network Dialog Box from Displaying
When Using a Zen Application with TCP/IP

Depending on the settings for your browser, the Windows Dial-Up Networking dialog box can
display when a TCP/IP request is made. Usually, this is to make an Internet connection, but this
feature can be an annoyance when using Zen applications and TCP/IP.

To prevent the dial-up networking dialog box from displaying automatically

1. In Control Panel, double-click Internet Options.

2. Click the Connections tab.

3. Clear the Dial whenever a network connection is not present option (select one of the other
options, such as Never Dial a Connection).

Changing the Default Communication Ports

Zen uses three communication ports for remote access to the server database engine:
» 3351 for the MicroKernel Engine

» 1583 for the Relational Engine

* 139 for named pipes




Note: Windows uses port 139 for operating system authentication. If you cannot open port 139
through a firewall, you can enable Zen database security to authenticates users instead of the
operating system. See To turn on security using Zen Explorer and To create a new user using Zen
Explorer in Advanced Operations Guide.

For the Relational Engine, port assignment 1583 is configurable on the server through the Zen
utilities. This port is manually configurable for clients. See TCP/IP Port in Advanced Operations
Guide.

In applications that access the MicroKernel Engine through URIs, port 3351 can be overridden
with a URI that includes the elements btrv://servername:port/database. Since overriding this port
may have unforeseen consequences, we recommend contacting Technical Support for discussion
before doing so.

Ensure that the port configurations match on both the server and all clients.

After changing your server listening port, you must stop and restart your database engine for the
port assignment changes to take effect. See Using Zen in Zen User’s Guide.

Services File

The services file is a text file used for network communications. In the file you can manually
assign the ports used by a Zen server and its clients. Be sure that the applicable ports listed in the
services file are in agreement with the ports set by Zen in the utilities and with the associated
Windows Firewall rules.

After changing port assignments in the services file, you must stop then start the Zen database
engine for the changes to take effect.See Starting and Stopping the Database Engine in Zen User’s
Guide.

Windows FireWalls

Zen installation performs certain firewall actions. Windows Defender Firewall with Advanced
Security provides firewall profiles that enable the firewall by default. The following table
summarizes the Zen installation actions pertaining to these profiles.

Active Firewall Profile! ~ Rules Added for Zen Services State of Rules After Installation?

¢ Domain * Domain — Yes ¢ Domain — Enabled
e Private e Private — Yes * Private — Enabled
¢ Public * Public — Yes * Public — Disabled
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Active Firewall Profile! ~ Rules Added for Zen Services State of Rules After Installation?

Public only Yes Enabled

I'"Active" means that the profile is monitoring network connections.

2 An "enabled" rule means that inbound TCP and UDP traffic can communicate with the Zen service on
all ports for any network connection managed by that firewall profile.

As the table shows, if the Public profile is active with one or more other active profiles, the Zen
rules are added for the Public profile but disabled. Neither the interactive nor the silent
installation of a Zen product can be modified to change this behavior. If you want to enable the
rules for the Public profile, you must do so manually. See To enable Zen rules for the Public
profile.

To enable Zen rules for the Public profile
1. Open the console for Windows Firewall with Advanced Security.
2. Click Inbound Rules in the left pane.

3. Locate the desired Zen rule in the list in the center pane.

Note that the rules are listed twice. The enabled rules (indicated by a check mark on a green
circle) apply to profiles other than Public. The disabled rules apply to the Public profile.

4. Right-click the disabled rule you want then click Properties.
5. Click the Advanced tab. Ensure that the Public profile is selected. If not, select it.

Click the General tab, then click the Enabled option.

= o

Click OK.

8. Exit the console for Windows Firewall with Advanced Security.

Profile Changes After Installation

If you change a network profile affer installation, Zen may no longer be able to accept
communications. For example, assume that only the Private network profile was active during
installation. At some point after installation, the active profile is changed to Domain (assume its
settings are very different from those of Private). The database engine will no longer be able to
communicate across the network.

If you change profiles or firewall rules in a way that prevents Zen communications, refer to the
steps in To enable Zen rules for the Public profile. Use the steps as a general guideline for how to
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enable the Zen rules for the active profiles. This will allow the database engine to communicate
again across the network.

Notes About Policies

A corporate policy may prevent a local administrator from modifying the firewall profiles on a
particular machine. If so, the Zen installation cannot add or enable the firewall rules required for
the database engine to communicate across a network connection monitored by a profile blocked
in this way. For such a situation, you should contact a corporate systems administrator and request
that the firewall policy be modified to allow inbound TCP and UDP traffic on all ports to
communicate with all installed Zen services.

Also be aware that a Group Policy only prevents the installation from adding and enabling rules
on firewall profiles controlled by the Group Policy when the target system is joined to the domain.
If the user installing Zen is logged into the target system as a local user instead of as a domain
user, the installation does add and enable the rules on the firewall profiles. However, the rules are
disabled if the target system is later joined to the domain controlling the Group Policy.

Using TCP/IP to Connect a Windows Client to
Linux or Raspbian Servers

Your Samba must be properly configured on your Linux or Raspbian server to network with
Windows-based clients when using mapped drives.

Configuring a Client for the Server IP Address

When Zen operates in a TCP/IP network, your client must be able to obtain the IP address of your
Linux or Raspbian server from the name given to that server. Two mechanisms enable this
translation of address to name:

* DNS (Domain naming service)

+ Editing the hosts file
The following procedures provide an overview for how to set up the IP address using each

method. For details about network configuration and set up, see the documentation for the
operating system.
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Using DNS to Configure the Server IP Address

When you use DNS, you specify settings that allow your computer to look up the address of the
server in a database of servers. Your network administrator can provide the information you need
to configure DNS.

To configure your clients to use DNS to resolve the server IP address

For clients on Windows platforms:

1. From the operating system, access the Network information.

2. Select the Properties for Local Area Connection.

3. Select the Properties of the TCP/IP connection being used (IPv4 or IPv6, for example).

4. Enable DNS and enter the appropriate server information from your network administrator.

Using the Hosts File to Configure the Server IP Address

The hosts file is a way to manually enter a relationship between a name and an IP address. Use
this method if DNS is not used in your organization.

To edit the hosts file on your Windows client

1. Find the hosts file on your Windows system.

For example, on certain Windows platforms it is located here:
ZWINDIR%\SYSTEM32\DRIVERS\ETC\HOSTS

2. Edit the hosts file with a text editor such as Notepad.

3. Enter your server IP address and name in the hosts file as a new line as shown in the following
example. Your network administrator can provide you with the IP address of your server.

# the following is an example of a hosts file entry for IPv4 address

146.23.45.2 acctserver

Preventing the Windows Dial-Up Network Dialog Box from Opening

The Windows Dial-Up Networking dialog box can open when a TCP/IP request is made to
Windows. Usually, this is to make an Internet connection, but this feature can be an annoyance
when you are using Zen applications and TCP/IP.
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To prevent the dial-up networking dialog box from displaying automatically
1. In Control Panel, double-click Internet Options.
2. Click the Connections tab.

3. Clear the Dial whenever a network connection is not present option (select one of the other
options, such as Never Dial a Connection).

Data Encoding

The use of encoding methods is intended for advanced users. In general, the default encoding
settings are sufficient and do not require changing. See Database Code Page and Client Encoding
in Advanced Operations Guide.

Using the DOS Requester

Zen supports DOS Btrieve applications with the DOS Requester. The DOS requester supports
Btrieve applications only, not ODBC applications. This topic explains how to use the DOS
requester to run Zen-based DOS applications in Windows.

DOS Box support allows a DOS application to run in a DOS box on a Windows platform. This
enables direct communication to the Windows 32-bit workstation components rather than to the
database engine. This configuration can be used with either a local Zen Workgroup engine, or a
remote engine. The TCP/IP protocol supported for client-server access depends on the
configuration of the Windows 32-bit components.

Supported Configurations

The DOS requester supports both Workgroup and Client to remote Zen server configurations.

DOS Box Support on Windows

The Requester for Windows is BTRBOX. You can use this Requester for DOS applications.

Running DOS Applications on Windows 32-bit Platforms

All of the components needed to run DOS applications using BTRBOX are installed with your
client. After the Windows client component installation, you have everything you need to run a
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DOS or Windows 32-bit application. The default DOS application support installed is the Win32
DOS Box configuration.

DOS applications are not supported on 64-bit Windows platforms. Therefore, BTRBOX is not
supported on 64-bit Windows platforms.

Using DOS Box Support

On Windows platforms, the DOS Box install configures the drivers to be completely transparent.
Thus, you are able to immediately open a command prompt and run a DOS Btrieve application.
The CONFIG.NT file, located in the %WINDIR%\SYSTEM32 directory, contains the command
that enables DOS application support. This file is similar to CONFIG.SYS in DOS. The Windows
operating system loads the driver for each DOS session opened. In the configuration file, the
install places the following path to load the DOS Box driver:

DEVICE = CAWINDOWS\SYSTEM32\BTRDRVR.SYS
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Setting Up a Workgroup Engine

The following topics discuss how to set up and use various configurations of Workgroup Engine,
including use of the Gateway Locator utility for a gateway configuration:

¢ Overview

» Setting Up a Small Client-Server Configuration
» Setting Up a Peer-to-Peer Configuration

» Setting Up a Gateway Configuration

* Running the Workgroup Engine as a Service

Overview

This topic explains the basic concepts and requirements of Workgroup engines. For in-depth
information about Workgroup Engine, see Advanced Operations Guide. It includes instructions
on setting up a gateway configuration and redirecting locator files.

Installation Requirements

Every computer that may be used to access the same data at the same time must have a
Workgroup engine installed on it.

Operating System Security

Only database server engines can enforce file security at the operating system level based on the
privileges assigned to the login user name. The Workgroup engine does not attempt to do this. In
a small office, where Workgroup engines are most common, this can be considered a plus because
the fewer barriers to successful data access, the better.

When to Use Workgroup

Typically, Workgroup engines use one of three configurations: small client-server, peer-to-peer,
and gateway.
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Small Client-Server Configuration

This configuration is useful when all data is located on the single computer where the Workgroup
engine is installed, and data sharing is limited.

Peer-to-Peer Configuration

A peer-to-peer topology may be called for when the Workgroup engine must access data
distributed across more than one workstation. This configuration is used when applications store
much of their own data on their local hard drive, but periodically they need to access data on other
workstations or share their local data with them.

In this configuration, each computer shares its data directories. Any remote computer that needs
access to the data then maps one or more drives to the shared directories. Then the Workgroup
engine on each computer acts as a mini server engine to read and write all changes to the data files
on that machine.

Gateway Configuration

The third Workgroup topology is for data stored on a file server where there is no MicroKernel
engine. This system can be a Unix or other type of network file server that gets backed up
regularly but cannot support a MicroKernel engine. In this situation, the first Workgroup engine
that opens files in a directory on the server becomes the gateway to each file in that directory. The
other workstations access the data in a client-server fashion through that gateway engine.

The gateway engine for a given directory identifies itself by a file named ~PVSW~.LOC in that
directory. This file is called a gateway locator file and contains the network name of the computer
where the gateway engine is located. For other Workgroup engines to communicate with the
gateway engine to access its data, they must read the locator file to find it.

You can ensure that the same engine always services the files in a given directory by making the
locator file read-only. This gateway is permanent and is called a fixed gateway. See To set up a
fixed gateway for more information.

The gateway engine acts as a server engine as it reads and writes pages to the data files, allowing
it to make the most use out of its cache. The gateway feature is designed so that the ownership of
any particular directory can change whenever the current gateway engine has no more client
applications with any files open in that directory. When the last data file is closed in a directory by
a given database engine, the engine releases and deletes the locator file. When the next engine
opens a data file, that engine becomes the new gateway to the directory where the data files
reside.
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What is a Gateway Engine?

A gateway engine is a Workgroup engine that acts as the sole point of access to all data files in a
particular directory on a remote file server. If several Workgroup engines are accessing the same
database at the same time, they do not all open the files simultaneously, nor do they share the files.
Rather, the first Workgroup engine to access that database becomes the temporary “owner” of
those files, and all other Workgroup engines must access the data by contacting the gateway
engine. Only the gateway engine has the files open and reads or writes the files. The other
Workgroup engines act as clients, making requests to the gateway engine acting as a mini server
engine.

Caution! Make certain the gateway computer is not shut down while users are still using it as a
gateway, or data loss can occur.

A gateway engine only comes into play when no database engine is installed on the machine
where the data files are, or when the database engine on that machine is not operating.

Setting Up a Small Client-Server Configuration

As explained in Small Client-Server Configuration, you should use this set up when you have
only a few workstations sharing data located on a central computer where you have a Workgroup
engine installed.

If you have data located on many computers, or if you do not or cannot install a database engine
on the computer where the data is located, you should use one of the other configurations.

To set up a small client-server configuration

1. You must have the Workgroup Engine installed both on the central computer where the data is
and on all computers expected to access the data.

Ensure that the Workgroup Engine on the central computer where the data is located is
operational each time the computer is started, before any other database engines attempt to
access the data. Workgroup Engine starts by default if installed as a server. By default,
Workgroup Engine is installed to run as a service for a fresh installation. If Workgroup Engine
was installed as an application, ensure that the application starts if the computer is restarted.
See Running the Workgroup Engine as a Service.

Note: You may inadvertently fall into a gateway configuration if the database engine on the
machine where the data is located is not started when the computer is started. If another
Workgroup engine attempts to access the data and the local database engine is not running, the
other database engine may establish itself as the gateway for those data files.




You can resolve this situation by shutting down the computer where the data is located, and
starting it again, while ensuring that no other computers request data before the local Workgroup
engine is restarted. You may need to remove the file ~\PVSW~.LOC from the data directory to
ensure the gateway is not reestablished.

The best way to ensure that only the gateway services the file is to set a fixed gateway locator file
using the Gateway Locator utility.

2. Share the directory where the data is located so that other computers can map a drive to the
data directory.

3. Ensure that each workstation expected to access the data can access the named database on the
central computer. See Named Database in Advanced Operations Guide.

Setup is complete. The Workgroup engine on the machine where the data is located now acts
as a mini-server, to fulfill all requests for data on that machine.

Setting Up a Peer-to-Peer Configuration

As explained in Peer-to-Peer Configuration, you should use this set up when you have
workstations sharing local data as well as data located on many different machines, and each
machine has the Workgroup engine installed.

This configuration is similar to the small client-server configuration discussed above, except that
now every Workgroup engine is sharing data as a server.

If you have data located on only one computers, or if you do not or cannot install a database
engine on the computer where the data is located, you should use one of the other configurations.

To set up a peer-to-peer configuration

1. You must have the Workgroup engine installed on each computer where data is located, and
installed on all computers expected to access the data.

Ensure that the Workgroup engine on each computer where the data is located is operational
each time the computer is started, before any other database engines attempt to access the
data. Workgroup Engine starts by default if installed as a server. By default, Workgroup
Engine is installed to run as a service for a fresh installation. If Workgroup Engine was
installed as an application, ensure that the application starts if the computer is restarted. See
Running the Workgroup Engine as a Service.
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Note: You may inadvertently fall into a gateway configuration if the database engine on a
machine where data is located is not started when the computer is started. If another Workgroup
engine attempts to access the data and the local database engine is not running, the other database
engine may establish itself as the gateway for those data files.

You can resolve this situation by shutting down the computer where the data is located, and
starting it up again, while ensuring that no other computers request data before the local
Workgroup engine is restarted. You may need to remove the file ~PVSW~.LOC from the data
directory to ensure the gateway is not reestablished.

The best way to ensure that only the gateway services the file is to set a fixed gateway locator file
using the Gateway Locator utility.

2. On each computer where data is located, share the directory where the data is located so that
other computers can map a drive to the data directory.

3. Ensure that each workstation expected to access the data can access the named database to
which the data belongs. See Named Database in Advanced Operations Guide.

Also, ensure that each Workgroup engine can access any local data from its own physical
drive.

4. Set up is complete. The Workgroup engine on each machine where data is located now acts as
a mini-server, to fulfill all requests for data on that machine.

Each Workgroup engine also handles any local data access, that is, database requests from
applications on that machine for data that resides on the same machine.

Setting Up a Gateway Configuration

As explained in Gateway Configuration, you should use this setup only when you have data files
on a computer where no database engine is installed.

If you have database engines installed on all machines, you should use one of the other
configurations.

Note: Your Worksgroup engine configuration may inadvertently function as a gateway if the
database engine on a system where data is located is not started when the computer is started. If
another Workgroup engine tries to access the data while the local database engine is not running,
the other database engine may automatically establish itself as the gateway for those data files.

You can resolve this situation by specifying a permanent gateway as described here or by
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restarting the computer where the data is located while ensuring that no other computers request
data before the local Workgroup engine restarts. You may need to remove the file ~PVSW~.LOC
from the data directory to prevent the gateway from reestablishing itself.

The best way to ensure that only the gateway services the file is to set a fixed gateway locator file
using the Gateway Locator utility.

Floating or Fixed Gateway

You can set up two different gateway configurations. The default behavior is a floating gateway
configuration. In this configuration, the first engine to open the remote data files becomes the
gateway engine for that directory until all files in the directory are closed. Then the next engine to
open the data files becomes the new gateway. This configuration is the most flexible, but also can
entail delays upon initial connection to the database, as the engine tries the different network
protocols and checks for an existing gateway engine.

Note: Using a floating gateway in a peer-to-peer configuration with multiple shared data sources
is not recommended. This configuration is supported and it operates as designed, however, with
multiple engines shuffling ownership among multiple data locations, connection delays may be
significant. It is also possible to create a situation where a Workgroup engine on a remote machine
serves as the gateway for data located on your local hard drive. Obviously there is no reason to
endure this delay when your local Workgroup engine can serve this data with higher performance.

You can avoid this situation by ensuring that the Workgroup engine on every computer is started
when the computer is started. You must also ensure that someone logs on to each computer,
because normally the Workgroup engine does not start until a user logs on.

You can also avoid this situation by permanently assigning each machine as the gateway for the
data files located on it. See To set up a fixed gateway for information on how to perform this task.

The second configuration is permanent and is called a fixed gateway configuration. In this
configuration, a specific engine is permanently assigned as the gateway engine for a specific
directory. If that engine is not running when another engine attempts to access the data, an error
code results and the data is not available.

To set up a floating gateway

1. This is the default behavior. Be sure that each Workgroup installation can access the named
database and its data. See Named Database in Advanced Operations Guide.
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The gateway assignment now floats dynamically as different remote Workgroup engines
access data from their respective locations.

To set up a fixed gateway

To specify a permanent gateway engine for a given directory, you need to change the attributes of
the ~PVSW~.LOC file to read-only, once it contains the name of the desired engine. There are
several ways to perform this task.

Use the Gateway Locator Utility

1. Access Gateway Locator from the operating system Start menu or Apps screen or in ZenCC
from the Tools menu.

2. Inthe Target Directory area, enter or browse for the directory containing the data files for
which you wish to set up a permanent gateway.

3. In the Directory Status area, click Change. In the dialog box that appears, click Assign a
Gateway, then type in or browse for the network name of the computer that you want to be the
gateway. Click OK.

4. Back in the main Gateway Locator window, check Permanent assignment. Click Exit.

Use a Command Prompt

Use the attrib +r command at a command prompt to change the attributes of the ~PVSW~.LOC
file.

Use Windows Explorer

1. In the directory where you want to make a permanent gateway assignment, right-click the
~PVSW~.LOC file and select Properties.

2. Inthe Properties dialog box on the General tab, under Attributes select Read-only and click
OK.

Working with the Gateway Locator Utility

The Gateway Locator utility provides control of and insight into any gateway configuration on
your network. This topic explains how to use the utility for a variety of purposes.

The utility enables users to determine or change the Workgroup Engine used as the gateway for
the data files in a particular directory. It is used only with the Workgroup Engine.
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The Gateway Locator operates by reading and manipulating the locator file ~PVSW~.LOC,
which resides in any directory which is assigned a gateway engine. If this file is in use and
therefore locked, the Gateway Locator can only locate, not change, the Workgroup engine being
used as a gateway for that particular directory.

To start the Gateway Locator utility

1. Access Gateway Locator from the operating system Start menu or Apps screen or in ZenCC
from the Tools menu.

&) Gateway Locator - x
Target Directory
A Work Group Engine or
Brieve Engine can [C:\Program Files\Actian\Zen\bin =]
potentially open files on
any machine in the unc |

network and serve the

files for other users, thus You can check the status of a directory by entering the path in
becoming a gateway. This the edit box and pressing the refresh button

utiity enables users to

check which engines are Directory Status

currently igned to . Iﬂi
serve as the gateway for Refresh Gateway assignedto | unassigne:

the files in a directory.

Permanent assignment [

Change | o ocator fie does not exist in the specified directory.
Gateway siatus refreshed

Exit

Note: The locator can be used to set the gateway for any data directory. Directory locations are
not stored with the tool, so you must always set the directory path before you click Change.

2. In Target Directory, enter or browse for the directory path which contains the data files for
which you wish to locate or change the gateway engine.

3. The default target directory is the current working directory. The browse button allows you to
find and select a new target directory.

Locating the Gateway Workgroup Engine

Once the target directory is selected, clicking the Refresh button causes the name of the gateway
engine for that directory (if such exists) to appear in the Gateway Assigned To box. If no
gateway exists for the chosen directory, the box reads “unassigned.”

Changing the Gateway Workgroup Engine

After selecting a target directory, click Change to choose the Workgroup engine to serve as
gateway for a particular directory. This button is disabled if the locator file for that directory is
locked. The following dialog box appears:
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Gateway Assignment X

Directory C:\Program Files\&ctian‘'Zen\bin

New Permanent Gateway Assignment

& Assign a gateway
Enter the computer name of the gateway

w00

" Do not assion a gateway

I oK I Cancel |

Enter or browse for the machine name you wish to serve as gateway.

Running the Workgroup Engine as a Service

By default, the Workgroup Engine is installed to run as a service for a fresh installation. Running
the Engine as a service allows the Engine to start automatically when the operating system starts.
A user is not required to log in to start the engine. No tray icon appears when you run the
Workgroup Engine as a service.

During installation, you can select to run Workgroup Engine as a console application. Or, if you
upgraded your Workgroup installation and you had the previous version installed to run as an
application, the upgrade installation is also set to run as an application. In either case, if you
decide that you would rather run the Workgroup Engine as a service, you change how it is run.

Configuration

To configure Workgroup Engine to run as a Service as opposed to an application, you must
reinstall Workgroup Engine. Choose Run As Service on the Engine Settings dialog box during
installation. See Installing Zen Workgroup for Windows.

Note: Running the engine as a service requires the Log On as Service privilege. If you select to
run the engine as a service under a user account other than the default Local System account, you
will need to modify the Log On Properties for the Service using the Windows Control Panel.

Note that on Windows platforms, a valid user name and password are required to access Zen
databases on another machine. "System Account" has no rights on other machines to Zen
databases.

If you want the Zen Workgroup service to access databases on another machine, then you must
specify a valid user name and password for the other machine, unless there is a running Zen
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Workgroup available locally on the other machine that can be used to access the databases
instead. Access the properties for the Zen Workgroup service. (Double-click the service on the
Services dialog.) In the Log On As section, check This Account and specify a valid user name
and password.

— Startup Type
oK
& Automatic I_I
' Manual Cancel |
" Disabled Help |

—Log On As:
' System Account

[ S ervice to Interact with Des)

( & This Account: Imyaccount )

Pazaword: I xxxxxxxxxxxxxx

LConfirm I xxxxxxxxxxxxxx

e ———

Stopping the Service

If you want to stop and then restart the service (but do not permanently remove the service), then
simply restart the machine.

You stop the service on Windows platforms just as you would any other service.

Stopping the Engine as a Service on Windows
1. In the Windows Control Panel, click Administrative Tools, then double-click Services.

2. Right-click the service name assigned to the Workgroup engine and click Stop.
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Setting Up a Client Reporting Engine

Big report queries can impose a large load on a Zen server, competing for resources with the
normal stream of smaller transactions. To reduce the load for report execution, you can set up Zen
Client Reporting Engine as a proxy server. This specialized 64-bit engine combines features of
Zen Relational Engine and Zen Client Cache engine to enable offloading of SQL reporting jobs to
lessen their impact on server activity. When big report queries run on the reporting engine instead
of on the server, server performance can rise for normal production operations.

A Client Reporting Engine is configured with the name of a Zen server as its “storage server,”
where the master copy of all data resides. Once configured, the reporting engine presents to SQL
clients all of the same databases as the master storage server, so that all SQL queries can then be
submitted to the reporting engine. Use of reporting engine requires you to make changes in your
design so that queries and other related requests are sent to this client instead of to the server.

Zen Client Reporting Engine has Windows performance counters to track cache usage. Zen
Enterprise Server and Cloud Server now have Windows performance counters that distinguish
between direct application use and use by remote cache engines, such as the reporting engine. In
addition, the counter for cache-hit-ratio has been changed to reflect recent activity instead of
cumulative.

Note: Although most database operations could successfully execute on this specialized engine,
it is designed for read-mostly reporting jobs. The Reporting Engine may be used by Btrieve
applications as an always-on Client Cache Engine.

The following topics cover server and client properties used in configuration:
» Server Properties for Client Reporting Engine

» Client Properties for Client Reporting Engine

» Database Properties for Client Reporting Engine

» Client Reporting Engine Limitations

Server Properties for Client Reporting Engine

Zen Client Reporting Engine has two additional server properties:

» Storage Server — Name of the Zen server installation that the Client Reporting Engine uses as
the master data copy. This installation can be either a Windows or Linux personal computer or
Server.
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« TEMPDB Directory — Location on the Client Reporting Engine to use as a temporary local
database. The default path is C:\ProgramData\Actian\Zen\tempdb, which on most systems is
satisfactory.

These two settings are not used by other Zen editions.

To begin using Client Reporting Engine, you need to set only the storage server name. Storage
server refers to the permanent location for data files, as opposed to data cached locally on this
client. Note that references to TEMPDB tables are processed locally on the reporting engine.

The rest of the server properties can be used with their default values or are unneeded and have
been removed. Server properties are documented under Server Configuration Properties on All
Platforms in Advanced Operations Guide.

To set the storage server
1. In ZenCC, expand the Engines node

2. Right-click the name of the Client Reporting Engine and select Properties.

[98)

. In the Properties window, click Access.

4. In the Storage Server ficld, enter the name or IP address of the Zen server to be supported.
The value is not case-sensitive.

5. Click Apply.

6. When ZenCC displays a message that the engine must be restarted, click OK.

7. Click OK to close the Properties window.

8. Expand the Services node, right-click Zen Reporting Engine, and select Restart Service.

9. To confirm that the Client Reporting Engine is connected and working properly, expand its
Engines node. Under the reporting engine name, you should see the list of storage server
databases.

To change the temporary database directory
1. In ZenCC, expand the Engines node.
2. Right-click the name of the Client Reporting Engine and select Properties.

3. In the Properties window, click Directories.
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4. In the TEMPDB Directory field, enter a new path. The location must exist on the system
where the Client Reporting Engine is running.

5. Click Apply.
6. When ZenCC displays a message that the engine must be restarted, click OK.
7. Click OK to close the Properties window.

8. Expand the Services node, right-click Zen Reporting Engine, and select Restart Service.

Client Properties for Client Reporting Engine

Zen Client Reporting Engine has a subset of the typical client properties. The following groups of
settings are not displayed because they are available under the server settings or are not needed by
the Client Reporting Engine:

* Cache Engine. The cache size can be changed in the Performance group of the server
properties for Client Reporting Engine.

» Cache Engine Debugging. The trace and debug settings can be changed in the Debugging
group of the server properties for Client Reporting Engine.

* Performance Tuning. The Use Cache Engine setting is always on, so this setting and group are
not configurable.

In general, the default values for the rest of the client properties enable a Client Reporting Engine
to function smoothly. Client properties are documented under Windows Client Configuration
Properties in Advanced Operations Guide

Database Properties for Client Reporting Engine

Do not attempt to change the settings for Zen internal databases, such as DefaultDB or TempDB.
In most cases, ZenCC issues messages and warnings that database properties cannot be modified
on a Client Reporting Engine.

To manage database properties, use ZenCC or bcfg on the storage server. In ZenCC, the settings
are listed in the Client Reporting Engine server Properties window under Access.




Client Reporting Engine Limitations

Because of the customized features of the Client Reporting Engine and the way it serves as a
proxy engine for a Zen server, it has the following SQL query limitations:

*  You cannot use CREATE DATABASE, DROP DATABASE, or MODIFY DATABASE.
*  You cannot modify database paths or code pages.

+ In the properties for a database, the Security settings group is disabled, and any attempt to use
SET SECURITY returns an error.

* You cannot create a table using an alternate collating sequence file.
*  You cannot reference an alternate collating sequence file in a COLLATE clause.

* You cannot create a table where the path specified in the USING clause is a relative path or
does not already exist. Attempting to do so results in a message that the file name is invalid.

* You cannot create a view or a stored procedure in a secure, V2 database. The Zen engine on
the storage server must set the permissions for the new object during this operation, which
cannot be done from the Client Reporting Engine. Attempts to do so return the message that
an error occurred while checking or setting security.

The workaround for these limitations is to run SQL queries locally on the storage server or
remotely from the Client Reporting Engine by connecting to the storage server through ZenCC,
befg, or other tool.

In addition, if you are running multiple applications on an individual Client Reporting Engine,
then to insure maximum cache synchronization, as a best practice we recommend that all of your
SQL applications connect through that Client Reporting Engine. The only exception is for
specific operations that require a direct connection to the storage server.

DDF Builder is disabled in Client Reporting Engine installations. If you try to use DDF Builder to
access a database, it displays a message that the database cannot be modified.

A Zen server on Windows [oT Core and Nano Server and on Raspbian cannot be used as a storage
server.

Using the Client Reporting Engine as a Btrieve Cache Engine

The Client Reporting Engine functions as a Client Cache Engine when it opens files on the
storage server or on another remote Zen database engine.

The Btrieve interface cannot open files local to the Client Reporting Engine. Attempts to do so
fail and may require the Btrieve session to be reset.
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All administrative concerns that apply to running Client Cache Engine as a service also apply to
running Client Reporting Engine. For example, it may be necessary to change the account under
which the service runs or to configure pvnetpass to use a Btrieve application with the Client
Reporting Engine. These concerns do not apply to applications that report using only SQL.

Using the Client Reporting Engine with the DTI API

The following DTI calls, as well as their DTO equivalents, fail when used locally on a Client
Reporting Engine:

» PvCopyDatabase()

* PvCreateDatabase()

* PvCreateDatabase2()
* PvDropDatabase()

* PvModifyDatabase()
* PvModifyDatabase2()
* PvSecureDatabase()

e PvUnSecureDatabase
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Application Configuration Scenarios

The following topics explain engine configuration settings for some common environment
scenarios:

* Terminal Services

» Active Directory Service

e Multiple Client Applications

* Concurrent Local and Remote Applications

* Accessing Data on Other Computers

Terminal Services

Microsoft Terminal Services is a multi session environment that provides remote computers
access to Windows-based programs running on a server.

Disabling Administrative Functions

In prior releases, the ability to perform administrative functions was prohibited from the client. In
the current release, Zen clients running within Terminal Services client sessions can perform Zen
administrative functions by default. For example, a user with such a client can change
configuration settings for Zen, create DSNs, and use the Monitor utility.

If you want to restrict this capability, intervention is necessary from a system administrator.

To disable remote administrative functions for Terminal Services clients

1. From ZenCC, open the properties for the MicroKernel Router under Local Client.

See To set the properties in ZenCC for a local client in Advanced Operations Guide.
2. On the Properties dialog, check Restrict Administrative Functions from a WTS Client.

3. Click OK, then exit ZenCC and start it again for the setting to take effect.

Note: Zen server engines are supported for use with Microsoft Terminal Server and Citrix
XenApp running within an Active Directory environment.
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Terminal Server as Network Server

You may use your terminal server as your main network server and database server. However, if
you have high usage of the server as a file server as well as many terminal sessions running at the
same time, you may find the performance less than satisfactory.

Another concern is having all of your mission critical services on the same machine. If it goes
down, all of your services go down at once.

For these reasons, you may wish to consider distributing your mission critical services on two or
more computers.

Workgroup Engine Running as a Service

By default, Workgroup Engine is installed to run as a service for a fresh installation. This allows
the engine to start automatically when the operating system starts. A user is not required to log in
to start the engine.

During a custom installation you can select to run the Workgroup Engine as a console application.
Or, if you upgraded your Workgroup installation and you had the previous version installed to run
as an application, the upgrade installation is also set to run as an application. In either case, if you
decide that you would rather run the Workgroup Engine as a service, you change how it is run.
See Running the Workgroup Engine as a Service.

Active Directory Service

Active Directory is a central component of the network architecture on certain Windows
operating systems. Active Directory provides a directory service specifically designed for
distributed networking environments.

This section describes the conceptual steps to configure Zen in an environment that has Microsoft
Active Directory service installed and functioning correctly.

Ensure that Active Directory service is installed and functioning correctly before you install Zen
into the environment.
Server and Client Support

Zen servers run on supported Windows Servers within an Active Directory environment. Zen
clients runs on all supported Windows platforms in Active Directory.
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Directory and File Permissions

The database engines enforce directory and file permissions set at the operating system level. An
Active Directory environment does not change this behavior. For example, if you set read-only
permission on a Zen table file, you will be unable to write to it.

Microsoft Terminal Services Support

Zen server engines are supported for use with Microsoft Terminal Server running within an
Active Directory environment. For more information about Terminal Services, seeTerminal
Services.

Zen Administrative Authority

Active Directory service manages the security of the network. You must grant the correct access
authority at the operating system level to users who need Zen administrative privileges.

See Active Directory Tasks for the general steps to set access authority. Users must have the
following authority on the machine running the database engine:

* Privilege to log on locally

* Administrator privileges or membership in the Zen Admin group
You can grant a user the privilege to log on locally or add the user to the Zen Admin group.

You can create the Zen Admin group on the machine running the database engine (the local
machine), on the domain controller for the local machine, or on both. The database engine checks
privileges first on the domain controller for the local machine then on the local machine.

An example helps illustrate this. Suppose you have two servers in your domain that run the Zen
database engine, Server A and Server B. You could create a Zen Admin group on each server and
on the domain controller. You then add User 1 to the group on Server A, User 2 to the group on
Server B, and User 3 to the group on the domain controller. User 1 has administrative privileges
for the database engine only on Server A. Similarly, User 2 has administrative privileges only on
Server B. User 3, however, has administrative privileges for the database engines on both Server
A and Server B.

If you create the Zen Admin group on a domain controller, then the group must be a domain local
group. If you create the Zen Admin group on a machine that is not a domain controller, then the
Zen_Admin group must be a local group.
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Active Directory Tasks

Use the following steps to create a Zen_Admin group in Active Directory to grant users Zen
administrative privileges in a Windows environment. The steps assume that you are setting
privileges on the domain controller for the machine running the database engine.

To add the Zen_Admin group as a default group policy

1. Create the Zen Admin group on the domain controller for the domain of the machine running
the database engine.

2. Specify Zen_Admin for the group name.

3. Set the group scope to Domain local. Do not use Global or Universal.
4. Add users to the Zen Admin group.

5. Confirm that the users appear as members of the group.

6. Add the Zen Admin group to the Log on locally privileges for the domain.

Note: If the Log on locally option is grayed out, skip step 6 and use the next task to continue
administrative group setup as a local policy.

To add the Zen_Admin group as a local policy

These steps continue from step 5 in the previous task when you cannot use the Log on locally
option in a group policy.

1. Click Start, enter gpmc.msc, and press Enter.

2. Double-click the name of the forest to open it.

3. Open Domains.

4. Open the name of the domain to which you want to join a computer.
5. Right-click Default Domain Controllers Policy and select Edit.

6. In the console tree, expand Computer Configuration > Policies > Windows Settings > Security
Settings > Local Policies, and then select User Rights Assignment.

7. In the details pane, open Allow Logon Locally.
8. Confirm that Define these policy settings is selected.

9. Click Add User or Group.
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10. Do one of the following:
* Enter the user account to allow to log on locally.

» Click Browse to find the account with the Select Users, Computers, or Groups dialog box.

11. Click OK in each dialog box until you have closed them all.

Multiple Client Applications

Sometimes, two or more client-server applications may use the same database engine. You will
need to configure the database engine differently depending on whether the applications are used
at the same time.

If your vendors supply configuration guidelines for engine configuration parameters, you will
need to adjust your configuration based on these guidelines.

If the applications run concurrently (that is, if two or more applications are using the database
server at the same time) ...

You should configure the engine by adding together all the recommended values for each parameter. For
example, if one application vendor suggests Performance Tuning | Number of Input/Output Threads
should be set to 4, and another application vendor suggests this parameter should be set to 8, then you
should set it to 12.

If the default value is higher than the sum of the recommended settings, then do not change the default
value.

Do not add up the recommended values for any buffer size settings, or log file size settings. Use the
largest recommended setting. Again, do not change the default if it is larger than any vendor
recommendation.

If the applications do not run concurrently (that is, if only one application is running at any given
point in time) ...

You should configure the server by using the largest recommended value for each parameter. For
example, if one application vendor suggests Performance Tuning | Number of Input/Qutput Threads
should be set to 4, and another application vendor suggests this parameter should be set to 8, then you
should set it to 8.

If the default value is higher than the largest recommended setting, then do not change the default value.
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Settings Affected by Multiple Applications

Most engine settings are not affected when you are running multiple applications. This section
explains the settings that may need to be adjusted for multiple applications.
Compatibility | Create File Version

Some applications may require that new files be created with version 7.x file format, while other
applications may require the default version 9.5.

These applications can run concurrently only if new files are not created during run time. There is
no way to toggle the setting back and forth for each application, unless you wish to do it by hand
or write a program to do so using Distributed Tuning Objects.

If the applications do not create new files during run time, then this setting is not relevant for
multiple applications.
Data Integrity | Transaction Durability

Some applications may require durable transactions, while others may not. If you have two
application vendors recommending different values for this parameter, then you should set it to
On. Generally, having transaction durability turned on does not affect applications that do not use
transactions, but may slow performance.

Concurrent Local and Remote Applications

Zen Server engines allow both remote client requests as well as communications from
applications running on the same computer as the server.

Note: To perform these steps, you must have full administrator rights on the machine where the
database engine is running, or be a member of the Zen Admin group defined on the machine
where the database engine is running.

To configure database connections from both remote and local applications

Tip... When changing server engine settings, you must be at the Windows system where the
database server runs.

1. Access Control Center (ZenCC) from the operating system Start menu or Apps screen.

2. In Explorer, expand Engines to display the engines registered with ZenCC.
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Right-click the target engine and click Properties. Log in if prompted.

Click Access. In the right-hand pane, select the Accept Remote Requests check box.

If you wish to prevent the server from accepting client connections from other computers,
clear the check box.

Click OK.

This configures the server to accept remote requests.
In Explorer, expand Local Client.
Right-click MicroKernel Router and select Properties. Log in if prompted.

Click Access. In the right-hand pane, select the following check boxes:

* Use Local MicroKernel Engine. Select this check box to configure the local engine for
local file access.

» Use Remote MicroKernel Engine. Select this check box to access databases on other
computers.

If you plan to only access data on this computer, clear this check box.
Click OK.

This configures the server to accept local requests.

10. Restart the server engine to implement the changes.

Using Server and Workgroup Engines Concurrently

The Workgroup engine can be configured to access files on a remote file server through a mapped
drive on a Windows server.

The client software installed with Workgroup can be used to connect to other database engines on
a remote machine.

If you want to use your local engine for local file access and a remote server for access to files
being serviced by the remote Zen server, you must change the settings in your MicroKernel
Router. Use the Zen Control Center to change MicroKernel Router settings.

To configure local and remote access for the MicroKernel Router

1.

Access Control Center (ZenCC) from the operating system Start menu or Apps screen.

2. In Explorer, expand Local Client.




3. Right-click MicroKernel Router and select Properties. Log in if prompted.

4. Click Access. In the right-hand pane, select the following check boxes:

* Use Local MicroKernel Engine. Select this check box to configure the local engine for
local file access.

» Use Remote MicroKernel Engine. Select this check box to configure the remote server for
access to files being serviced by the remote Zen server.

5. Click OK.

Note: See Advanced Operations Guide for more information on changing settings using Zen
Control Center.

Accessing Data on Other Computers

Workgroup Engine provides great flexibility for a variety of small networked environments. The
table below explains the most common configurations and where to look for more information. In
any of the following configurations, Workgroup Engine must be installed on every computer that
is expected to access data.

Configuration Where to look for more information

Small client-server Setting Up a Small Client-Server
Data resides on a single computer where a workgroup engine  Configuration
is installed.

Peer-to-Peer Setting Up a Peer-to-Peer Configuration
Data resides on two or more computers where workgroup
engines are installed.

Gateway Setting Up a Gateway Configuration
Data resides on a file server where no database engine is
installed, or it is not running.
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Installing Zen for Linux-based Systems

The following topics explain how to install and uninstall Zen Enterprise Server, Cloud Server,
and Zen Client on Linux and Raspbian.

» Before You Install on Linux or Raspbian
» Installing Zen Using TAR
« After Installing Zen on Linux or Raspbian

» Uninstalling Zen on Linux or Raspbian

Before You Install on Linux or Raspbian

Before installing or upgrading Zen Enterprise Server, Cloud Server, Edge Server, or Client,
review the following information:

» System requirements listed in the Zen release notes, readme zen.htm, which also includes
other late-breaking updates that may not be included in the user documentation.

* Preparing to Install Zen — Important information, including platform-specific notes.

You must be logged in as root to install any of the products. If you are installing from a CD, you
must be at the CD root directory.

If you have any trouble with an installation, see Troubleshooting After Installation.

Full and Client Installations on Linux-Based Systems

Zen offers the following 64-bit full and client installations:
» TAR packages for Linux and Raspbian

A full installation includes the engine and client files, utilities, and the complete user
documentation. Client installations provide only files needed to support a client, including
utilities and documentation. If you have 32-bit applications, support is provided as an additional
client access installation. The following table lists the installation packages.

Zen Product Installation Contains

Enterprise Server 64-bit  Full Engine and client files, utilities, and documentation.
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Zen Product Installation Contains

Edge Server 32-bit Subset of Engine and client files, a subset of CLI utilities, no

(Raspbian only) full server documentation. See Utilities on Raspbian for the list of items
provided.

Cloud Server 64-bit Full Engine and client files, utilities, and documentation.

Client 64-bit Client Client files, utilities, and documentation.

Client 32-bit Subset of Client files, a subset of CLI utilities, no documentation. See

(Raspbian only) client Utilities on Raspbian for the list of items provided.

Client Access 32-bit Client Client files and limited 32-bit utilities. Installed after one of

(Linux only) the other three products to enable database access for 32-bit
applications.

Note: Glibc and stdc++ packages are prerequisites for the
Client Access installation. Before installing Client Access,
you can add them from the repository of your Linux
distribution using a yum command:

yum install glibc.i686 libstdc++.i686

Utilities on Raspbian

On Raspbian systems, Zen provides a subset of the command line utilities that are available in full
installations. These utilities consist of the following:

befg btadmin clipaadm dsnadd psregedit pvddl
bdu butil dbdefrag isql psregsvr pvnetpass
bmon clilcadm dbmaint licgetauth pvdbpass rbldcli

Connecting from Linux-Based Clients to Windows Enterprise
Server or Cloud Server

The Server Message Block (SMB) protocol enables network access to the Zen MicroKernel
Engine from a Linux or Raspbian client at the Btrieve file level. You can find information about
SMB-compatible file sharing at www.samba.org. For more information on remote Btrieve-level
access, see Supported Path Formats for Samba.

If your database server engine fails to meet certain installation requirements, your applications
may receive the status code “3031: Linux requester cannot connect to this server,” indicating a
client-server incompatibility. In some cases, you may receive “94: The application encountered a
permission error.”
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Installing Zen Using TAR

The tape archive (TAR) format allows you to install Zen on Linux and Raspbian. The following
topics explain how to install Zen products using TAR:

» Installing Zen Enterprise Server of Cloud Server for Linux and Raspbian - TAR
* Installing Zen Client for Linux and Raspbian - TAR

If you have any trouble with installation, see Troubleshooting After Installation.

Installing Zen Enterprise Server of Cloud Server for Linux and
Raspbian - TAR

The name of the Zen server installation package uses the conventions in the following table.

Installation Type Platform Package Name

Enterprise Server 64-bit x86-64 Zen-EnterpriseServer-linux-x86_64-yy.yy.zzz.zzz.tar.gz
Enterprise Server 64-bit ARMO64 Zen-EnterpriseServer-linux-aarch64-yy.yy.zzz.zzz tar.gz
Cloud Server 64-bit x86-64 Zen-CloudServer-linux-x86_64-yy.yy.zzz.zzz tar.gz
Cloud Server 64-bit ARM64 Zen-CloudServer-linux-aarch64-yy.yy.zzz.zzz tar.gz
Edge Server 32-bit ARM32 Zen-Edge-Server-linux-armhf-yy.yy.zzz.zzz tar.gz

In the file name, yy.yy is a release number and zzz.zzz is a build number. See the file for its actual
name.

Your installation is either a first time, with no previous version, or an upgrade to an existing
installed version.

* First-Time Zen Server Installation on Linux and Raspbian

» Upgrading a Zen Server Installation on Linux and Raspbian

First-Time Zen Server Installation on Linux and Raspbian

The 64-bit installation scripts perform the following tasks:
* Verify necessary permissions to complete install
» Create user zen-sve and group zen-data if they do not exist

» Sets user:group ownership to zen-svc:zen-data for the installed files if not already set
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To install a Zen Server on Linux or Raspbian

1. Log in as the root user.

2. Change to the /usr/local directory.
cd /usr/local

3. Enter the following command to copy the .tar file to /ust/local.
For example, if you downloaded the installation package to /home/bholly:
cp /home/bholly/<server_package_name> .

4. Unpack the .tar file using the following command.
tar -zxf <server_package_name>

5. Change directories to the /ust/local/actianzen/etc folder where the installation scripts reside.
cd actianzen/etc

6. Run the installation script:
./install.sh

The installation is complete. For additional information, see Installing Zen Using TAR.

Upgrading a Zen Server Installation on Linux and Raspbian

If you have a previous version of Zen already installed, you must uninstall that version and then
install the new Zen product. See Uninstalling Zen on Linux or Raspbian for more information.

Installing Zen Client for Linux and Raspbian - TAR

The name of the Zen Client installation package uses the conventions in the following table.

Installation Type Platform Package Name

Client 64-bit x86-64 Zen-Client-linux-x86_64-yy.yy.zzz.zzz tar.gz

Client 64-bit ARM64 Zen-Client-linux-aarch64-yy.yy.zzz.zzz tar.gz

Client 32-bit ARM32 Zen-Edge-Client-linux-armhf-yy.yy.zzz.zzz tar.gz
Client Access 32-bit x86 Zen-Client-Access-linux-x86 64-yy.yy.zzz.zzz.tar.gz

In the file name, yy.yy is a release number and zzz.zzz is a build number. See the file for its actual
name.
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Your installation is either a first time, with no previous version, or an upgrade to an existing
installed version.

First-Time Client Installation on Linux and Raspbian

If you need to provide 32-bit client access for an application, you must install the Zen Client 64-
bit first, and then add Zen Client Access 32-bit. Note that 32-bit client access does not apply to
Raspbian systems.

To install Zen Client for Linux Using TAR
1. Log in as the root user.

2. Change to the /usr/local directory.
cd /usr/local
3. Enter the following command to copy the .tar file to /ust/local.
For example, if you downloaded the installation package to /home/bholly:
cp /home/bholly/<client_package_name> .
4. Unpack the .tar file using the following command.
tar -zxf <client_package_name>

The unpacking action creates a directory named zenclient.

5. Change directories to the /ust/local/actianzen/etc folder where the Zen installation scripts
reside.

cd actianzen/etc
6. Run the installation script needed by the client package that you are installing:
* Client 64-bit: ./clientinstall.sh
or

* Client Access 32-bit: ./clientaccessinstall.sh
The TAR installation is complete. For additional information, see After Installing Zen on Linux or
Raspbian and Setting Up Network Communications for Clients.
Upgrading a Client Installation on Linux and Raspbian

If you have a previous version of Zen already installed, you must uninstall that version and then
install the new version. See Uninstalling Zen on Linux or Raspbian for more information.
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After Installing Zen on Linux or Raspbian

The following topics may be useful after you install Zen on Linux or Raspbian:
« Verifying Database Engine is Running

* Server Configuration

* Client Configuration

* Licensing

* Common Questions After Installation

» Using Zen on Linux and Raspbian

Verifying Database Engine is Running

Optionally, after the installation script finishes, you can verify that the database engine is running
with the ps command. To do this, enter the following at a command prompt:

ps -e | egrep mkded

Server Configuration

Generally, the default configuration settings for Zen Enterprise Server and Cloud Server are
sufficient. See Configuration for settings that you may want or need to set.

If you want to explore all of the configuration settings, see Configuration Reference in Advanced
Operations Guide.

Client Configuration

All configuration settings for Zen Client are discussed in Linux and Raspbian Client
Configuration Properties in Advanced Operations Guide.

For additional information about clients, see Installing Zen Clients for Windows and Setting Up
Network Communications for Clients.
Linux and Raspbian Clients and the Monitor Utility

This information applies only to Linux or Raspbian clients that use a static IP address. Ignore it if
you use DHCP and have a DSN to resolve named addresses.
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When you monitor clients using the Zen Monitor utility, the client IP address that gets transmitted
across the network originates from the hosts file. If the system name and IP have not been added
to the hosts file, network communication uses the local host IP address, which is 127.0.0.1 or ::1

(a loopback address).

If you change the loopback address to the correct IP, or if you add the system name and IP to the
hosts file on the client, the client name is displayed correctly in the Monitor utility.

Licensing

Once you have completed installation, you may need to update your license to increase the user
count for Zen Enterprise Server or to increase the session count or data in use limits for Cloud
Server. See Increase User Count or Data in Use in Zen User’s Guide.

Common Questions After Installation

If you have problems with your installation, see Troubleshooting After Installation or get help
online from the Zen knowledge base at the Actian website. The following are common questions
after installation of the products:

« Where Do Files Reside After Installing Zen on Linux and Raspbian?
* How Do I Access the Documentation?

*  What If I Get Errors Trying to Start the Utilities?

Where Do Files Reside After Installing Zen on Linux and Raspbian?

The following table lists the primary directories and files that result from installation on Linux or
Raspbian. SACTIANZEN ROQOT refers to the root directory where the files are installed. By
default it is set to /usr/local/actianzen. Unless otherwise noted, the primary directories and files
are the same for 32- and 64-bit products.

For an upgrade installation, your existing Zen files were updated to the latest versions.

Path from Primary Description Applies to

SACTIANZEN_ROOT Files Installation of

J LICENSE License information Server

/bin Binary files, executables Server and Client

/bin/plugins A directory of files for utilities and  Server and Client
documentation
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Path from Primary
SACTIANZEN ROOT Files

Description

Applies to
Installation of

./data/Demodata Sample Zen database Server
./data/samples Sample Btrieve files, alternate Server
collating sequence file and the
DefaultDB system database
Jetc Server and Client
.PSRegistry Zen registry of configuration Server
settings (this directory and its
subordinate directories)
btpasswd User passwords file Server
dbnames.cfg  Master table of database names Server
odbc.ini ODBGC settings Server and Client
J1ib Library of 32-bit shared objects Server and Client
/lib64 Library of 64-bit shared objects Server and Client
Jlog Transaction log files directory Server and Client
/man/manl Man pages for the command-line Server and Client

utilities

How Do | Access the Documentation?

The documentation installed with Zen includes the following:

* Man pages for command line utilities

* Documentation Library

» Release Notes

Man Pages

Man pages are provided for the command line utilities. To make these man pages available, add
$ACTIANZEN_ROOT/man to the MANPATH environment variable.

Man pages are installed with Zen Enterprise Server, Cloud Server, and Client. Command line
utilities are also covered in the user documentation.




Documentation Library

The Zen documentation library contains the complete set of user documentation, including the
user documentation for the Zen engine and software development kit.

The documentation library is integrated into Zen Control Center (ZenCC). You can access the
documentation library in the Welcome tab opened from the Help menu or by pressing F1
(Windows) or Shift F1 (Linux) to open context-sensitive topics.

Release Notes

The release notes in readme_zen.htm contain general information about the release, sometimes
including late-breaking advice not yet covered in the user documentation. These release notes are
located in the /usr/local/actianzen/docs/ directory and are linked in the Welcome tab opened from
the Help menu in ZenCC. The Actian website posts the latest version of the release notes.

What If | Get Errors Trying to Start the Utilities?

See Starting ZenCC on Linux in Zen User’s Guide and Starting DDF Builder from a Command
Line in DDF Builder User’s Guide.

Uninstalling Zen on Linux or Raspbian

This topic provides a table that lists the shell scripts used to remove Zen installations. The
uninstalling of a TAR package is slightly different for Linux and Raspbian, as shown in the
following steps.

To uninstall a Zen TAR installation on Linux and Raspbian
1. Atacommand prompt, log in as the root user using the su command.

2. Change directories to the /usr/local/actianzen/etc folder where the Zen installation scripts
reside.

cd /usr/local/actianzen/etc

3. Use the uninstall scripts from the following table that apply to your installation.

Package To Uninstall Scripts To Execute from /usr/local/actianzen/etc, Where They Reside
Enterprise Server 64-bit Juninstall.sh
Client 64-bit /clientuninstall.sh
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Package To Uninstall

Scripts To Execute from /usr/local/actianzen/etc, Where They Reside

Client Access 32-bit
(Linux only)

./clientaccessuninstall.sh

Note: Client Access should be uninstalled before uninstalling the 64-bit
package to which it has been added.




Using Zen on Linux and Raspbian

The following topics are for Zen users on the supported Unix-based platforms:
* Finding What You Need

e Zen Account Management on Linux and Raspbian

* Configuration

* C(Client Information

» Setting Up Web-based Data Access

* Using Perl and ODBC with Zen

Finding What You Need

Accessing the User Documentation

See How Do I Access the Documentation?

Man Pages

The man pages are installed with Zen Enterprise Server, Cloud Server, and Client. See the
directory SACTIANZEN ROOT/man/manlfor the man pages available.

To make these man pages easily accessible, add $ACTIANZEN_ROOT/man to your MANPATH
environment variable. If you need more detailed information on a utility or application, see
Command Line Interface Utilities Zen User’s Guide.

Note: Check the man pages for the most current information. Every effort is made to ensure that
the information in this guide matches that in the man pages. On occasion, last-minute changes
may be included in the man pages after this guide has been published.

Zen Account Management on Linux and Raspbian

The following topics provide information on Linux and Raspbian user accounts with respect to
operation of Zen. Use of the .bash shell is assumed, but similar instructions should apply to other
shells.
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After Installation Behavior

» User zen-svc has no password and can be accessed only through the root account using su.
* You can access the .bash_profile for user zen-svc with ~zen-svc/.bash_profile.

* All Zen files have user:group ownership zen-svc:zen-data

*  You must be logged in as root to run the start and stop scripts for the Zen engines.

* You can run utilities on other user accounts if you add needed environment variables to the
user .bash profile or system /etc/profile. See Using Ultilities from Users Other Than zen-svc.

» In addition to the instructions under Using Ultilities from Users Other Than zen-svc, users
other than root must be a member of the group zen-data to perform functionality with the
following utilities:

» Zen Control Center (ZenCC) to administer the local server.

» License Administrator utility (clilcadm) for functions other than displaying current
licenses.

» Named Database Maintenance utility (dbmaint) for functions other than displaying current
databases.

» Zen Service Registry Editor (psregedit) for functions other than displaying the registry.

* Command line configuration (bcfg).

The User Environment

The single environment variable SACTIANZEN ROOT is used to determine the location of
installed components.

The generic location for configuration files are SACTIANZEN ROOT/etc.
For executable files, the location is SACTIANZEN_ ROOT/bin.

For shared libraries (32-bit) the location is SACTIANZEN ROOT/lib; for shared libraries (64-
bit) the location is SACTIANZEN ROOT/1ib64.

We recommend that you add $ACTIANZEN_ROOT/bin to your Path environment variable.

As described in the next topic, add $ACTIANZEN_R00T/1ib64 to LD LIBRARY PATH on Linux
and Raspbian.

If you are using the 32-bit Client Access package, you also must add SACTIANZEN ROOT/lib
to LD LIBRARY PATH.




Using Utilities from Users Other Than zen-svc

To use utilities from user accounts other than zen-svc, you must first make modifications to the
user account configuration. Copy the lines from the following example to either the profile for a
specific user or to the /etc profile that all users inherit.

/home/username/ .bash_profile Profile for the user. Similar to /etc/profile but only for the
current user.

/etc/profile Default profile for all user accounts on the system. Use this
profile to grant access to Zen utilities to all user accounts.

Changing this profile according to the example given does not
grant administrative privileges or access to Zen data.

Example of a Modified Profile

Be sure to export all variables specific to Zen.

ACTIANZEN_ROOT=/usr/local/actianzen

PATH=$PATH:$ACTIANZEN_ROOT/bin:/bin:/usr/bin
LD_LIBRARY_PATH=$ACTIANZEN_ROOT/1ib64:$ACTIANZEN_ROOT/1ib:$ACTIANZEN_ROOT/bin:/usr/
lib

MANPATH=$MANPATH : $ACTIANZEN_ROOT/man

Configuration

Generally, the default configuration settings for Zen servers and clients are sufficient. You
typically do not have to configure any settings for the database engine and clients to
communication and function together correctly. This topic discusses two settings that you may
want or need to configure:

« Samba Configuration File

e Authentication

If you want to explore all of the configuration settings, see Configuration Reference in Advanced
Operations Guide:

Samba Configuration File

A Zen server defines the path to the Samba configuration file (smb.conf), which is parsed on
engine startup to determine mapping between share names and server directory locations. See
Configuration File (Linux and Raspbian Engines Only) in Advanced Operations Guide.




Authentication

This setting offers several options for the type of authentication to use for access to the server
engine:

Emulate Workgroup Engine. Use this value when Samba is used to authenticate user access
on the system.

Proprietary Authentication (using btpasswd). Use this value when not using Samba and the
user does not have an account on the server. This allows a separate password file to be
maintained when connecting to the Linux or Raspbian system.

If you are using BTPASSWD or PAM authentication on your Linux or Raspbian server, user
names and passwords must be set up using the pvnetpass utility on the clients connecting to
this server. For more information about pvnetpass, see the Zen User’s Guide.

Standard Linux Authentication. Use this value when Samba is not used, but users have
accounts on the Linux or Raspbian system.

Supported Path Formats for Samba

Windows Client

From a Zen client on Windows, the order of path parsing is as follows:

\\server\share\relative\path
Share denotes a valid Samba share, made accessible to a Windows client.

Server reads smb.conf to determine the absolute path to the shared directory, then combines it
with the relative path to get a full path. The location of smb.conf is essential for valid
resolution of the file path supplied in this format on the client. If the relative path is not
correct, status code 12 is returned.

Drive:\path

Drive must be a Samba drive mapped on the Windows client, from which the Zen client
determines the server where the Btrieve file resides.

Linux or Raspbian Client

From a Zen client on a Linux or Raspbian, the order of path parsing is as follows:

//server/share/relative/path

Share denotes a valid Samba share name on the server.




On systems that use a third-party Samba package, server reads smb.conf to determine the
absolute path to the shared directory, then combines it with the relative path to get a full path.
The location of smb.conf is essential for valid resolution of the file path supplied in this
format on the client.

If the relative path is not correct, an error status is returned.
* /Mount/path
Mount must be a Samba drive mounted on the Linux or Raspbian client, from which the Zen

client determines the server where the Btrieve file resides.

Note: Share names for clients for a Linux-based server are case-sensitive. If the share name on
the server and the client do not match exactly, they cannot communicate.

On Linux and Raspbian servers, if the Zen engine cannot find either smb.conf or a share name, it
assumes a default of \\server\absolute\path format. If the absolute path is not correct, status 12 is
returned.

Client Information

Zen Client on Linux or Raspbian can connect to any of the Zen Servers, provided that the client
and server machines communicate with a shared protocol.

Authentication to Remote Machines

To connect to a remote machine using the Linux or Raspbian client, you must be able to
authenticate to the remote machines. This is accomplished by using the pvnetpass utility to send a
user name and password to the server. This utility stores the user name and password in an
encrypted format for that particular server in the Zen registry on the client machine. If you do not
specify user names and passwords, your applications can receive status code 3119.

See pvnetpass in Zen User’s Guide.

Creating a Client DSN

A client data source name (DSN) is required if applications on the client use the Zen Relational
Engine through ODBC. To create a client DSN, you use the dsnadd utility included with the Zen
Client. See dsnadd in Zen User’s Guide and the man page for dsnadd located in /usr/local/
actianzen/man/manl.
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Setting Up Web-based Data Access

The following topics cover the configuring of web servers to provide access to Zen data and
provide connection snippets and samples for accessing Zen data from web applications on Linux.
Raspbian is not supported for this use case.

ODBC Behavior

When you first install Zen, the odbc.ini file is written to /usr/local/actianzen/etc.

If you have other ODBC driver managers such as unixODBC, they may use an odbc.ini file in a
different location, such as /etc/odbc.ini.

One way to unify the ODBC setup is to add soft links from between the Zen directories and the
location where unixODBC expects to find the odbc.ini file, as shown in the following example:

su
cd /etc
In -s /usr/local/actianzen/etc/odbc.ini

Configuring Web Server

This topic shows how you should set up the machine where the web server such as Apache
resides.

You should make the user account under which you run any web server such as Apache a member
of the group zen. These user accounts run under restricted accounts such as nobody

To find the user account, see your Apache configuration file, typically located at /etc/httpd/conf/
httpd.conf.

In this file, the following lines show the user that the Apache server operates under:

User nobody
Group nobody
Options ExecCgi Indexes

You should add this user to the zen-data group, substituting the name used in your Apache
configuration file.

/usr/bin/gpasswd -a nobody zen-data




PHP

PHP allows for easy development of web applications, using a style that is similar to both ASP in
the Microsoft world and JSP in the Java world. Using PHP, you enclose database calls in special
tags and format the output using HTML.

Zen PHP Requirements

 PHP - obtain from https://www.php.net

* DSN pointing to the database (use dsnadd)

PHP Connection Snippet

This code segment shows the essential part of connecting to a Zen database using PHP.

// connect to Demodata database no uid or password
$connect = odbc_connect("demodata", "", "");

// set the query variable to your SQL
$query = "SELECT * from Department";

// obtain a result object for your query
$result = odbc_exec($connect, $query);

PHP Sample

This sample presents the user a choice of three Demodata tables and then displays the table.

<HTML>

<HEAD>

KTITLE>PHP Sample</TITLE>

</HEAD>

<BODY>

<H1>Hello World Samples - PHP using PHP ODBC APIs)</H1>
<p>

This sample will display the Demodata database tables in the following drop-down
by using PHP.

</p>

<?

/] ------- MATIN MENU== === ==iccmicmoim e mmoom o mo o= = o

// if there is no function specified in the URL

if (!(isset ($HTTP_GET_VARS[" function"]))):

/| ===ssesscsscossssoossossossoosossoosoosoosos

?>

<p>Please select from the following tables</p>

<form method=post action='<?=$PHP_SELF?>?_ function=showtable'>
<select name="selecttable">

<option SELECTED value="Department">Department

<option value="Course">Course

<option value="Room">Room

</select>

<p>

<input type=submit value="Show table">

</p>
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</form>

<?

)] comosos SHOWTABLE - === == === == oo m oo e e e e
Elseif ($HTTP_GET_VARS[" function"] == "showtable"):
[ =eccomcocsemoconsossossorssrneosssosonsoones

print("<p>Return to <a href='$PHP_SELF'>Sample 1 Main menu</a></p>");

$thetable = $HTTP_POST_VARS["selecttable"];

// determine from FORMS data which table to open

$connect = odbc_connect("demodata", "", "");

// connect to Demodata database no uid or password
$query = "SELECT * from $thetable";

// set the query variable to contain the SQL you

// want to execute
$result = odbc_exec($connect, $query);

// perform the query

// print out the entire resultset as HTML table

// (uncomment following line)

// odbc_result_all($result);

// or format the output yourself and display

// a nicer table (but more code required)

// initialize row counter

$i = o;

// determine number of columns

$numcols = odbc_num_fields($result);

// start HTML table

print("<table border=1 cellpadding=5>");

// Print column headings

print("<tr>"); // start of row

while ($i < $numcols)

$it++;
$colname = odbc_field_name($result, $i);
print("<th>$colname</th>");

$i=0;
print("</tr>"); // end of row
// Print table data
// while there are still rows
while(odbc_fetch_row($result))

print("<tr>"); // start row
while ($i < $numcols)

$it++;
$tablecell = odbc_result($result, $i);
print("<td>$tablecell</td>");

print("</tr>"); // end row

$i = 0; // reset counter
} // end odbc_fetch_row
print("</table>"); // end HTML table
odbc_close($connect); // CLOSE THE CONNECTION
// End of showtable
// ---Catch invalid menu options-----------------
Else:
A R L L ELE L
print("<p>An Invalid function was entered. Please <a href='$PHP_SELF'>try again</a>.</p>");
Endif;
?>
</BODY>
</HTML>




Perl

Perl allows for both command line and web-based applications using Zen.

Zen Perl Requirements

* Perl

+ ODBC-DBD library

* CGI library

» DSN pointing to the database

Perl Connection Snippet

This code segment shows the essential part of connecting to a Zen database using Perl.

# specify use of Perl database interface (DBI)
use DBI;

# connect to Demodata database no uid or password
$dbInfo = "DBI:ODBC:DEMODATA";

$dbUserName = "";

$dbPassword = "";

# set the query variable to your SQL

$query = "SELECT * FROM Department";

# Connect to the server

$connect = DBI->connect($dbInfo, $dbUserName, $dbPassword);
# Prepare the SQL query

$myRecordSet = $connect->prepare($query);

# Execute the query and obtain a recordset

$myRecordSet->execute();

Perl Sample

This complete sample presents the user a choice of three Demodata tables and then displays the
table.

# Perl sample

use CGI":cgi-lib";

$cgiquery = new CGI;




$functionreq = $cgiquery->url_param('_function');
# use 'url_param' for GET and 'param' for POST
print &PrintHeader;

print &HtmlTop("Hello World Sample - Perl");
print <<ENDOFMENU;

<H1>Hello World Samples - Perl</H1>

<P>

This sample will display the Demodata database tables in the following menu list by using Perl/DBI.

</p>
ENDOFMENU
#----- MAIN MENU-------------------—-——-——————-

# if there is no function specified in the URL

if (!$functionreq) {

print <<ENDOFTEXT;

<p>Please select from the following tables</p>
<form method=post action="$ENV{'SCRIPT_NAME'}? function=showtable">
<select name="selecttable">

<option SELECTED value="Department">Department
<option value="Course">Course

<option value="Room">Room

</select>

<p>

<input type=submit value="Show table">

</p>

</form>

ENDOFTEXT

} # !($function)

elsif ($functionreq eq "showtable") {
print("<p>Return to <a href='$ENV{'SCRIPT_NAME'}'>Perl Hello World Sample - Main Menu</a></p>");
# determine from FORMS data which table to open

$thetable = $cgiquery->param('selecttable’);




use DBI;
$dbInfo = "DBI:ODBC:DEMODATA";

$dbUserName = "";

$dbPassword = "";

$query = "SELECT * FROM $thetable";

$connect = DBI->connect($dbInfo, $dbUserName, $dbPassword);

$myRecordSet = $connect->prepare($query);
$myRecordSet->execute();
# start HTML table
print "<table border=1 cellpadding=5>";
# Print column headings
$num_fields = $myRecordSet->{NUM_OF FIELDS};
$count = 0;
print "<tr >";
while ($count < $num_fields) {
$column_name = $myRecordSet->{NAME}->[$count];
print "<th>$column_name</th>";
$count++;
}
print "</tr>\n";
$count = 0;
# Print table data
while(@row=$myRecordSet->fetchrow_array) {
print "<tr>\n";
while ($count < $num_fields) {
print "<td>$row[$count]</td>\n";
$count++;
}
print "</tr>\n";
$count = 0;
}
print "</table>"; # end HTML table

# END OF SHOWTABLE
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else {
print "<p>An Invalid function was entered. Please <a href='$ENV{'SCRIPT_NAME'}'>try again</a>.</p>";

}

print &HtmlBot;

Using Perl and ODBC with Zen

Note: This procedure assumes you have a working installation of Zen, Perl, and an ODBC
distribution. A free version of ODBC is available at www.iODBC.org. Perl can be found at

www.perl.org.

To Get Zen to work with the Perl ODBC Interface

1. Download the database interface (DBI) support for Perl.

Read the readme or installation files for instructions.

2. Download the ODBC DBD database driver for Perl.

Please see the installation instructions in the readme or installation files.

3. Make sure that you have the proper environment variables set, as shown in the following
example. These settings are also explained in the iODBC docs.

Code Snippet for Perl and DBI

print "using odbc...\n";

use DBI;

$dbName = "DBI:ODBC:DEMODATA";

$dbUserName = "";

$dbPassword = "";

print "connecting...\n";

$sql = "SELECT * FROM class";

$dbh = DBI->connect($dbName, $dbUserName, $dbPassword);
$dataObject = $dbh->prepare($sql);
$dataObject->execute();

while(@row=$dataObject->fetchrow_array)




{
print "$row[@]\t$row[1]\t$row[2]\n\n"

}
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Installing on Windows Nano Server or
Windows loT Core

The following topics cover installation and configuration of Zen Enterprise Server, Edge Server,
Client, and Client Reporting Engine on Windows Nano Server and Windows loT Core:

» Before You Install on Windows Nano Server or IoT Core
* Installing Using PowerShell
» After Installing on Windows Nano Server or [oT Core

e Uninstalling on Windows Nano Server or [oT Core

Before You Install on Windows Nano Server or loT
Core

Before installing Zen on these platforms, we recommend you review the release notes from the
Actian website. Also, be aware that throughout the documentation, all references to Zen
Enterprise Server apply to installations on Windows Nano Server and IoT Core systems as well.

You must be logged in as administrator to install Zen on Windows IoT Core.

Special Instructions Before Installing Nano Server in a Docker
Container

The release of Windows Nano Server 2019 is supported only in a Docker container. Building
Nano Server 2019 in a Docker container to install Actian Zen would involve pull commands like
those given here.

Windows Platform

For Windows 10 Professional, the image can be pulled by the following command:

docker pull mcr.microsoft.com/windows/nanoserver:1909-amd64

For Windows Server 2019, the image can be pulled by this command:

docker pull mcr.microsoft.com/windows/nanoserver:1809-amd64
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Windows PowerShell

Actian Zen installation on Nano Server 2019 requires Windows PowerShell. Its image can be
obtained with the following command:

docker pull mcr.microsoft.com/powershell:nanoserver

DLL File netapi32.dil

The Zen database engine requires the netapi32.dll to load and run properly. This standard
Windows DLL is not included by default in the Nano Server image. To include the needed file,
add the following line to your dockerfile. The string nnnn refers to the Windows image used.

COPY --from=mcr.microsoft.com/windows/servercore:nnnn
["\\Windows\\System32\\netapi32.dll", "\\Windows\\System32"]

After you have completed these instructions and executed docker run to run a dockerfile like the
following sample, you can continue with the steps under Installing Using PowerShell.

Sample Dockerfile

# escape="

# Args used by from statements must be defined here
ARG InstallerVersion=nanoserver-1809

ARG InstallerRepo=mcr.microsoft.com/powershell

# Use powershell with nanoserver

FROM ${InstallerRepo}:$InstallerVersion

USER ContainerAdministrator

# In the following line, the /M is required to address a known Docker issue in Windows Nano Server
2019.

RUN setx PATH "%PATH%;%ProgramFiles%\PowerShell;" /M
#Pull in netapi32.dll from servercore
## FROM mcr.microsoft.com/windows/servercore as core

COPY --from=mcr.microsoft.com/windows/servercore:1809 ["\\Windows\\System32\\netapi32.dll",
"\\Windows\\System32"]

# intialize powershell module cache
RUN pwsh °
-NoLogo

-NoProfile °




-Command "

$stopTime = (get-date).AddMinutes(15); °

$ErrorActionPreference = 'Stop' ; °

$ProgressPreference = 'SilentlyContinue' ; °

while(!(Test-Path -Path $env:PSModuleAnalysisCachePath)) {
Write-Host "'Waiting for $env:PSModuleAnalysisCachePath'" ; °
if((get-date) -gt $stopTime) { throw 'timeout expired'} °
Start-Sleep -Seconds 6 ; °

%

CMD ["pwsh.exe"]

Installing Using PowerShell

Microsoft PowerShell and the .zip archive format are used to install Zen on Windows Nano
Server or IoT Core. The following topics explain how to use these to install Zen.

* Choosing a .Zip Archive for Installing

» First-Time Installation on Windows Nano Server or [oT Core

» Upgrade Installation on Windows Nano Server or [oT Core

Choosing a .Zip Archive for Installing

Depending on the operating system where you install, choose a .zip file from the following table.

Windows Zen Products .Zip Archive

Platform Supported

Nano Server Enterprise Server, Install-Zen-Bundle-winuwp-x86_64-yy.yy.zzz.zzz.zip
Edge Server, Client,
Client Reporting
Engine

IoT Core, x86  Enterprise Server, Install-Zen-Edge-Bundle-winuwp-x86_64-yy.yy.zzz.zzz.zip
Edge Server

IoT Core, Enterprise Server, Install-Zen-Edge-Bundle-winuwp-arm32-yy.yy.zzz.zzz.zip

ARM32 Edge Server

In the file name, yy.yy is a release number and zzz.zzz is a build number. See the file for its actual

name.
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A server installation includes the engine and client files and selected utilities. Client installations
provide only files and utilities needed to support a client. Client Reporting Engine installations are
the same as those on other Windows platforms.

Your installation is either a first time, with no previous version, or an upgrade to an existing
installed version.

First-Time Installation on Windows Nano Server or loT Core

For Nano Server, be sure to read Special Instructions Before Installing Nano Server in a Docker
Container. After choosing a .zip file and copying it to the target system, proceed with the
following steps. After completing them, see Windows Firewall Configuration.

To install using PowerShell

1. On the target system, start a PowerShell session as Administrator. On Nano Server you may
use a dockerfile like the sample given under Special Instructions Before Installing Nano
Server in a Docker Container.

2. Extract the installation .zip archive to a location accessible to the PowerShell session that will
execute the installation script.

3. In the extracted files, run Install-Zen.ps1 with an argument to select the Zen product.
» For Nano Server, the arguments are enterpriseserver, edgeserver, client, or reporting.
* For IoT Core, the arguments are enterpriseserver or edgeserver.
Note: See information about Zen Edge Server on [oT Core after these steps.

The installation displays progress information in the console and creates a log file in the user's
temp folder $env:temp. The name of the log file reflects the type of installation that was
chosen: Zen <type> PowerShell Install.log.

After installation, you can reclaim disk space by removing the .zip archive and its extracted files.

About Zen Edge Server on Windows loT Core

An Edge Server installation is identical to the Enterprise Server installation except for the
following:

* License can be activated only on Universal Windows Platform (UWP) systems with 4 GB
memory or less.

* Applies the temporary license key in the file install edgeserver.cfg.




* Adds "INFO: Total Physical Memory : <size in_bytes>" in the file
Zen EdgeServer PowerShell Install.log.

Windows Firewall Configuration

Zen installation for Windows Nano Server and Windows [oT Core systems requires that Windows
Firewall rules allow communication through the firewall. These rules are not enabled by default.
To enable them, run the PowerShell script Enable-ZenFirewallRules.ps1, which is included in a
default Zen installation in C:\Program Files\Actian\Zen\bin. If needed, you can enter one of the
following arguments to enable the rules only for the specified Windows Firewall profile:

* domain
* private
* public

* any (default)
The following example enables the firewall with the domain argument:
PS> & "C:\Program Files\Actian\Zen\bin\Enable-ZenFirewallRules.ps1l" domain

If you enter no argument, then rules for all Windows Firewall profiles are enabled, the same as if
you had entered the argument any. After the script is executed, it displays the current state of the
rules for all profiles.

Upgrade Installation on Windows Nano Server or loT Core

To upgrade an existing installed version of Zen on Windows Nano Server and Windows loT Core,
repeat the installation steps using a new .zip archive.

You do not need to redo changes made to Windows Firewall rules after the first installation.

After Installing on Windows Nano Server or loT
Core

The following topics may be useful after installation. Throughout the documentation, references
to Zen Enterprise Server apply to installations on Windows Nano Server and [oT Core systems.
» Server Configuration

* Client Configuration




* Licensing
* Code Page Configuration on Windows [oT Core Systems

* Common Questions After Installation

Server Configuration

All configuration settings for Zen Enterprise Server are available on Windows Nano Server and
[oT Core. Generally, the default configuration settings are sufficient. For information on these
settings, see Configuration Reference in Advanced Operations Guide.

Client Configuration

Basic configuration settings for installations of Zen Client are discussed in Setting Up Network
Communications for Clients. For information on all client settings, see Windows Client
Configuration Properties in Advanced Operations Guide.

Licensing

On both Windows Nano Server and [oT Core, Zen uses license keys instead of product keys.

Code Page Configuration on Windows loT Core Systems

In the current release, the code page for a Zen installation on Windows IoT Core defaults to
Western European 1252. You can change the code page using PowerShell. For example, if you
want to change the setting to Microsoft Windows 932 for Japanese systems, use the following
command:

Set-ItemProperty -Path HKLM:\SYSTEM\CurrentControlSet\Control\Nls\CodePage -Name ACP -Value 932

Common Questions After Installation

If you have problems with your installation, see Troubleshooting After Installation or get help
online from the Zen knowledge base at the Actian website. The following are common questions
after installation of the products:

* How Can I Verify That the Database Engine is Running?
« What Utilities Are Installed?
*  Where Do Files Reside After Installing?



https://www.actian.com/data-management/psql-embedded-database/

e  How Do I Access the Documentation?

*  Where Are the Release Notes?

How Can | Verify That the Database Engine is Running?

After the installation script finishes, you can verify that the database engine is running with the
PowerShell Get-Service command. To do so, enter the following at a command prompt:

Get-Service -DisplayName "Actian Zen Enterprise Server"
If the engine is running, this command returns the following:

Status  Name DisplayName

Running zenengine Actian Zen Enterprise Server
If the server engine is stopped, you can use the following command to manually start it:
Start-Service -DisplayName "Actian Zen Enterprise Server"

The engine service starts automatically with the operating system. If you need to stop the service,
use the following command:

Stop-Service -DisplayName "Actian Zen Enterprise Server"

After running this command, the Get-Service command returns the following:

Status  Name DisplayName

Stopped zenengine Actian Zen Enterprise Server

What Utilities Are Installed?
On Nano Server systems, Zen provides a subset of the command line utilities that are available in
full installations. These utilities consist of the following:

befg bmon clilcadm dbdefrag pvnetpass
bdu butil clipaadm pvddl

On IoT Core systems, the utilities consist of the following:

befg bmon clilcadm dbdefrag pvnetpass
bdu butil clipaadm pvddl
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Where Do Files Reside After Installing?

The following table lists the primary directories and files installed for Zen products on Windows
Nano Server or [oT Core. The variable % ALLUSERSPROFILE% is used to determine the
location of some files, while others default to C:\Program Files\Actian\Zen.

Location File Description Installation
C:\Program Files\Actian\Zen See License information in a Enterprise
description file: Server, Client

¢ Windows Nano Server
and IoT Core:
EULA en.rtfor
EULA_ Client_en.rtf

e arm32: LICENSE

C:\Program Files\Actian\Zen\bin

Binary files, executable
utilities, and so forth

Enterprise
Server, Client,
Client

Reporting
Engine
%ALLUSERSPROFILE%\Actian\Zen\Demodata Sample Zen database to Enterprise
create from a set of SQL Server
scripts in a directory named
restore
%ALLUSERSPROFILE%\Actian\Zen\samples Sample Btrieve files, Enterprise
alternate collating Server
sequence file and the
DefaultDB system
database
%ALLUSERSPROFILE%\Actian\Zen\. dbnames.cfg  Master table of database Enterprise
names Server
%ALLUSERSPROFILE%\Actian\Zen\log Transaction log files Enterprise

directory

Server, Client,
Client
Reporting
Engine

How Do | Access the Documentation?

No documentation is included in a Zen installation on Windows Nano Server or IoT Core. You

may use the documentation installed with other Zen editions or posted on the Actian

documentation website.



http://docs.actian.com
http://docs.actian.com

Where Are the Release Notes?

The release notes contain general information about the release, sometimes including late-
breaking advice not yet covered in the user documentation. Although this document is not
included in installations on Windows Nano Server or [oT Core, the Actian website posts the latest
version.

Uninstalling on Windows Nano Server or loT Core

Use the following steps to remove Zen from your system.

To remove Zen from Windows Nano Server or IoT Core

To remove Zen from the system, you use the script Uninstall-Zen.ps1. This script is located in the
Zen bin folder C:\Program Files\Actian\Zen\bin. You should invoke it from a working directory
located outside that path, as shown in the example used here.

1. On the system where Zen is installed, start a PowerShell session as Administrator.

2. Set the location as shown here:

PS> Set-Location c:\

Note: If the script is invoked from a location that is in the Zen installation folder path, the Zen
files and directories are not removed, and you must manually delete them after running the
removal script.

3. Run the removal script.
PS C:\> & "C:\Program Files\Actian\Zen\Bin\Uninstall-Zen.ps1"

The script displays status information in the console and creates a log file in the user's temp
folder $env:temp.

Removal is complete.
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Troubleshooting After Installation

Zen provides several features and tools that help to address configuration and installation
problems. Some of these utilities are installed and run as part of the installation process, and all
can be run later to evaluate configuration and registry settings and to troubleshoot problems. They
are shown in the following table.

The following topics cover different aspects of troubleshooting:

Troubleshooting Tools

Troubleshooting Strategies

Logged Messages

Configuration for Special Installation Situations
Diagnosing Problems with Zen System Analyzer
Verifying Database Engine is Running
Obtaining File, Client, and Engine Version Number
Engine and Client Version Conflicts

State of Key Is "Failed Validation" or "Disabled"
Troubleshooting Common Zen Issues

Issues After Uninstalling Zen on Windows

How to Get Additional Help

Troubleshooting Tools

The following table describes tools to help you avoid or solve problems.

originate from any Zen component.

Feature/ Function For More Information
Component

Zen System Analyzes system components and runs See Diagnosing Problems with
Analyzer communication tests. Zen System Analyzer.

Zen Message Logged messages can be of type status, See Reviewing Message Logs in
Logging information, warning, or error, and can Advanced Operations Guide




Feature/ Function For More Information
Component

Gateway Locator ~ Determines or changes the gateway used fora  See Setting Up a Workgroup
particular data dictionary (only in the Engine.
Workgroup edition.)

Troubleshooting Strategies

Typically, your installation process finishes with no problems. However, success depends on a
number of factors, including proper network support and operating system configuration. If
something does go wrong during installation, Zen offers some tools and troubleshooting
techniques to help diagnose the problem.

Note: If installation fails, look for the installation log file in the Windows %Temp% directory.

Checklist for Problems

Did you see any error messages displayed during installation?
Does the Network function correctly?

Do you have the appropriate administrator-level privileges?
Is the Engine running?

Is the Client software correctly functioning?

O 0O 0O 0 0O O

Are there errors in the zen.log file (Windows) or in syslog (Linux or Raspbian)?

Troubleshoot the Problem

The following topics cover procedures that you can use in verifying your installation.
* Logged Messages

* Configuration for Special Installation Situations

* Diagnosing Problems with Zen System Analyzer

« Verifying Database Engine is Running

« Obtaining File, Client, and Engine Version Number

* How to Get Additional Help




Logged Messages

Messages logged by Zen can help you troubleshoot problems. Messages can be of type status,
information, warning, or error, and can originate from any Zen component. Certain messages
specific to licensing issues originate only from the license administration components. In either
case, Zen writes messages to the following logging features:

* Notification Viewer
* Operating system event log

» Zen event log (zen.log) (Windows only)

Any licensing message logged to Notification Viewer is also logged to the operating system event
log and to the Zen event log. Similarly, any licensing message logged to the operating system
event log is also logged to the Zen event log. Note that the operating system event log and Zen
event log may contain licensing messages not logged to Notification Viewer.

Messages not specific to licensing are logged to the operating system event log and to Zen event
log.

Follow these guidelines for using messages to troubleshoot problems:

» Ifyou suspect a problem related to licensing, first check Notification Viewer, then check the
operating system event log and Zen event log.

» If you suspect a problem not related to licensing, check the operating system event log and
Zen event log.

For logging details, see Reviewing Message Logs in Advanced Operations Guide. For status code
details, see Status Codes in Status Codes and Messages.

Configuration for Special Installation Situations

This topic covers selected scenarios where the default configuration settings need adjusting for
proper database operation.

The following table lists some of these situations and the actions you can take.

If your computing Then you need to...
environment includes...

Microsoft Active Directory Read the topic Active Directory Service.
Service
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If your computing Then you need to...
environment includes...

Multiple network interfaces Enable a configuration setting that supports multihoming. In Advanced
Operations Guide, see TCP/IP Multihomed and Listen [P Address.

A network that is subject to Enable a configuration setting that can automatically reconnect to a
outages server after a network outage. In Advanced Operations Guide, see Auto
Reconnect.

Database file names that must ~ Enable a configuration setting that instructs the database engine to

not include embedded spaces  reject files with embedded spaces in the name. In Advanced Operations
Guide, see Embedded Spaces and Long File Names and Embedded
Spaces Support.

Diagnosing Problems with Zen System Analyzer
Zen System Analyzer (ZenSA) is a diagnostic tool. It is included with the database installation to
help with the following tasks:

* Troubleshoot network problems

* Detect previous installations of Btrieve or Zen on your system

» Note other factors that influence your networking environment

* View current component set and versions

Note: For information, see Zen System Analyzer (ZenSA) in Zen User’s Guide.

Verifying Database Engine is Running

To verify that the Zen engine is running, see the procedure for your platform and engine:
» Zen Servers on Windows
* Zen Workgroup on Windows

» Zen Servers on Linux-based Systems

Zen Servers on Windows

You can use the Windows Services control panel.




To check Actian Zen Enterprise Server Engine Service on Windows servers using the
Control Panel

1. At the operating system, open Services under Administrative Tools.

2. In the list of services, find the Actian Zen engine service.

This service must be running. The Status column shows when the service is running. The
Startup column shows whether the service is set to start automatically or manually.

3. Ifaservice is not started, right-click it, then click Start.

Zen Workgroup on Windows

To verity that Workgroup Engine is running:

To start Workgroup Engine
Click Start Workgroup Engine in the Start menu or Apps screen.

By default, the MicroKernel allocates resources and is ready to serve local application database
requests.

To stop Workgroup Engine
Click Stop Workgroup Engine in the Start menu or Apps screen.

A warning message appears when you try to stop the engine if any of the following are true:
* The engine has one or more active clients.
» No activity has taken place since the engine loaded.

» Less than 10 seconds has passed since the last operation took place.

Zen Servers on Linux-based Systems

You can the ps utility at a command line to verify that the engine (mkded) is running:
ps -e | egrep 'mkded'

To start the Zen service

If you need to start the engine service, run the following command under the root user account:

etc/init.d/actianzen start




Obtaining File, Client, and Engine Version Number

You can use Zen utilities to verify that the client and engines have the version number you expect,
or to check the version of a particular file.

Determining Client and Engine Version

You can check the engine and client versions using Function Executor on Windows platforms or
using the butil command line utility on all platforms. Function Executor is a utility that simulates
Btrieve client operations using the Zen requesters.

* Using Function Executor

» Using the butil Utility

Using Function Executor

Use Function Executor to determine the version of the client, local and remote engines.

To Determine the Engine Version using Function Executor
1. Access Function Executor from the operating system Start menu or Apps screen.

2. Do one of the following:
* Click View > Btrieve Version from the File menu.

* Select the Btrieve Version Info toolbar button.

File View Tools Help

|| ele - la([mal

3. Adialog box displays the version of the client requesters and the local engine. If a file is open,
the remote MicroKernel version is included.

9 Btrieve Version Information X
Client 14.00

Local MicroKemnel 1400 NT
Remote MicroKernel 14.00 NT

Using the butil Utility

From a command prompt, enter the following:

butil -ver




The requester and engine versions are then displayed. You cannot determine the version of a
remote server engine with this tool.

Determining a File Version

You can determine the file version of a MicroKernel data file using the Zen utilities. On the
Windows platform, use Explorer, Function Executor, DDF Builder, or Btrieve Maintenance. On
any platform, use the butil command line utility. The following topics give information on using
some of these methods.

» Using the Zen Control Center
» Using Btrieve Maintenance
» Using Function Executor

» Using the butil Utility

Using the Zen Control Center

You can use the Zen Control Center to determine a file version.

To Determine the File Version of a Table Using Zen Control Center
1. Access ZenCC from the operating system Start menu or Apps screen.
2. Find the database by expanding its name in Explorer on the left.

3. Do one of the following:
* Click a table name to choose it and select File > Properties from the File menu.

* Right-click the table name and select Properties.
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4. The table properties are displayed, which include the file version of the underlying

MicroKernel data file.

General Columns  Indexes

Parameter

Table Name

Table Location

Dictionary Path

File Version

Record Length

Page Size

Mumber of Records

MNumber of Indexes

MNumber of Unused Linked Duplicate ...
MNumber of Unused Preallocated Pages
Variable Length Records

Blank Truncation

Record Compression

Page Compression

Key Only File

Index Balancing

Freespace Threshold

Uses Alternate Collating Sequence
System Data

Value

Billing
CAPROGRAMDATANACTIANVPSQLND...
CAPROGRAMDATANACTIANVPSQLND...
9.5
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4096

1313

1

0

0

Mo

Mo

Mo

Mo

Mo

Mo

0%

Mo

Yes

Using Btrieve Maintenance

If you are unfamiliar with the command line, you can use the GUI-based Btrieve Maintenance

tool.

To Determine the File Version of a Table Using Btrieve Maintenance Utility
1.
2.

Open Maintenance.

Select Options > Show Information Editor.

In File Information Editor, select Load Information.

Enter the path or browse for a file and click Open.

The version appears at upper right under Data File Info.

Using Function Executor

The Function Executor utility can simulate Btrieve operations and can be used to determine the

file version by performing a statistics report against the file.

To Determine the File Version of a Table Using Function Executor

1.

Open Function Executor.




2. Select File > Open.

3. Inthe Open Btrieve File dialog, enter the path or browse for a file.

4. With the file open in Function Executor, select View > File Statistics or press Ctrl-S to see

the file version in the File Statistics window.

= C:\ProgramData\Actian\Zen\ Demodata13\BILLING. MKD - o x|
File Size 421888  Page Size [bytes) 4096
File Version 130 Number of Records 135
Record Length 139 Unused Preallocated Pages 1]
MNumber of Keys / Segments 1/6  Unused Linked Duplicate Pointers 1]
Open Mode Normal
Flags
Record Compression r Free Space Threshold 5%
Page Compression r Key Only [
Variable Records I Index Balancing I
Truncate Blanks r Page Preallocation [
Contains YATs r

P =0wpe M=MNod F=Fego Dupe AL =Nd ¢=Dave /=lavalnm

Key#  Seqg Unigue Paos Len Attibutes Data Type
0 | | Urisi i
1] 2 1315 3 1 M < Null
1] 3 1315 10 2 M Unsigned Binary
<
=15 =1

Function Executor is documented in more detail in Advanced Operations Guide.

Using the butil Utility

Use the -stat parameter of butil to see file statistics for information about the following:

+ File version

*  Owner name protection if used, including encryption level
» Page size, preallocation, and other characteristics

* Records

+ Keys

For example, the following command returns information for the file dept.mkd in the Demodata

sample database included with Zen, located in a default installation in
C:\ProgramData\Actian\Zen\Demodata:

butil -stat dept.mkd

The butil utility is documented in more detail in Advanced Operations Guide.
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Engine and Client Version Conflicts

We recommend that you use client requesters that are the same version as the database engine. If
you choose, you may use a client requester that is an older version than the database engine with
which it interacts. In some situations, depending on the type of SDK access method used by your
application, an older version requester will not work with the database engine. Your application
will be unable to communicate with the database engine. For those situations, you must use client
requesters that are the same version as the database engine.

Client requesters that are a newer version than the database engine may or may not function
correctly. Correct functioning of newer versions of client requesters with older versions of the
engine cannot be guaranteed. Therefore, we recommend that you avoid the use of newer version
client requesters with an older engine.

Note: See also Does the Zen Client version have to match the Zen Server version?, particularly if
you are using Zen Cloud Server.

State of Key Is "Failed Validation" or "Disabled"

Zen licensing components may determine that the product key for the database engine has
become invalid. If so, the state of the key changes from Active to Failed Validation. Usually, you
discover the invalidation after one of the following actions:

*  You manually run the command line utility clilcadm with the -t option to validate the key.

* You restart the Zen service, automatically prompting key validation.

Message logs and other notifications can alert you to a failed validation and possible reasons. The
most common reason is a change to the host name of the system where Zen is running.

After validation failure, the database engine continues to run normally for a set number of days,
called a failed validation period. This time period, set within product key itself, allows ample time
for you to correct the failure and move the key state from failed back to active.

You have three ways to find out how many days you have to do this:

* In License Administrator, the product key shows a state of Failed Validation and an expiration
date for the last day of the grace period.

» Zen Notification Viewer gives a history that includes licensing events. It lists any key
validation failure, the number of days left until expiration, and gives steps you can take for
correction.

* The file zen.log lists an entry for the validation failure that includes the expiration date.




If you do not correct the causes of the failed validation before the expiration date, the key changes
state to Disabled. A disabled key prevents the database engine from accessing data files.

For more information, see Reviewing Message Logs in Advanced Operations Guide and License
Administration Concepts in Zen User’s Guide.

Troubleshooting Common Zen Issues

This topic outlines problems you may encounter during the installation or when first using
Workgroup Engine.

I receive Status 7224 or my license is no longer listed in the License
Administrator utility.

When Workgroup Engine is installed as an application, you may experience this situation.
Applications do not automatically inherit the user’s administrative rights. You can stop the
engine, run it as administrator, and then run the command line or GUI License Administrator as
administrator to authorize the license. Another option is to install Workgroup Engine to run as a
service. See Running the Workgroup Engine as a Service.

| fail to see the effects of my configuration changes.

Try stopping and restarting the database engine. Whenever you make a change to engine
configuration settings, you must stop and restart the database engine for the changes to take effect.
For information on how to do this, see Verifying Database Engine is Running.

Why do | receive Status 7012 when trying to create a new database
with Workgroup Engine using ZenCC on Windows?

When ZenCC creates a new database, the new database name is added to dbnames.cfg and an
entry is added to the odbc.ini registry in order to create a corresponding System DSN.

Due to Microsoft operating system constraints on registry access, Workgroup Engine should be
run in an elevated mode, so that the database System DSN can be created.

Once the System DSN is created successfully, any user may start Workgroup Engine and use the
DSN.

Note: In Windows, standard users may create User DSNs without this restriction.
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Why do | (now) receive Status 95, after running my application
successfully?

Your application has lost its session with the database engine. This can happen if you make
changes to your configuration settings and must restart the database engine, as in the
troubleshooting example given above. At the moment the database engine is stopped, any
application that is running loses its session with the database engine. You must stop all those
utilities and restart them in order to reestablish communication.

See the Status Codes and Messages manual for more cases in which this status code can be
returned.

Installing a Zen application has rendered another application unusable.
If the latest DLLs have been overwritten, it is possible to restore the overwritten DLLs using a
backup directory that is automatically created when you install Zen.

How do I verify that my DOS components are functioning properly?

Zen provides the command line utility butil.exe for verifying that your DOS components are
functioning properly. In a default installation, it is located in C:\Program Files
(x86)\Actian\Zen\bin.

Why can’t | restart my application after an improper program exit?

Database engine components may remain in memory if the engine is interrupted improperly.

If you cannot restart your program after improperly aborting the application by using
Ctrl-C or stopping the process

1. Shut down and restart your system.

2. Avoid terminating applications in an abnormal manner.

Why isn't my application using Workgroup Engine?

If you previously installed Zen requesters and then later installed Workgroup Engine, but your
application is using only the requesters, you may have an outdated configuration that turns off
local access. The Workgroup Engine installation does not overwrite existing settings. To turn on
local access, see Using Server and Workgroup Engines Concurrently.




How Do | Access the Documentation?

To access the online documentation
1. Access Control Center & Documentation from the Start menu or Apps screen.

2. Click the desired manual on the ZenCC Welcome tab. If the Welcome tab has been closed,
click Help > Welcome.

I received an error message during installation that begins: "Setup did
not update the PATH statement in autoexec.bat because the new path
would be too long for Windows."

This message appears when the installation program cannot update the Path environment variable
because the resulting string would be too long. For information on how to increase the
environment space defined in config.sys, see Microsoft knowledge base articles.

If you get this error message, then a REM statement (a comment) has been added to your
autoexec.bat file. The REM statement contains the Path value that would have been entered. You
can change the Path statement manually.

The best approach, if possible, is to install the product in a location with a shorter installation
directory so that the Path value does not exceed the environment space.

Issues After Uninstalling Zen on Windows

After you uninstall Zen using Programs and Features in Windows, you should not have any
database engine files left on your system. However, certain actions such as restoring archived
components can cause a significant number of files to remain. This is a side-effect of how the
installation process works with the Windows operating system.

In the situations described previously, the files are left because Windows has them marked with
usage counts that indicate that they are being used by more than one program, and therefore the
uninstallation program does not remove them. This is expected behavior, but it may lead to a false
appearance that the Zen installer is not functioning correctly.

How to Get Additional Help

If you encounter problems during or after the installation that are not covered in the user
documentation, please contact technical support.
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